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Preface

Introduction
Cisco Desktop Administrator consists of two parts:
■

Desktop-based Cisco Desktop Work Flow Administrator

■

Web-based Cisco Desktop Administrator

Cisco Desktop Work Flow Administrator enables you to configure the following:
■

Dial strings

■

Phone book

■

Reason codes

■

Wrap-up data

■

Record/monitor notification

■

Work flows and agent desktops

Cisco Desktop Administrator enables you to configure the following:
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■

Services

■

Personnel and work flow group assignments

■

Cisco Unified Presence Settings
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What’s New In This Release
■

Ability to disable hyperlink dialing (click to dial)

■

Always on top window options for real time displays and dial pad

■

Import and export phone books

■

Phone book search filter

Desktop Administrator Feature Levels
There are three feature levels of Cisco Desktop Administrator: Standard, Enhanced,
and Premium.
The following table lists the features that are available in each feature level of
Desktop Administrator. Features that are not listed here are in all three feature levels.
Table 1.

Desktop Administrator features

Feature

Standard

Enhanced

Premium

Configure enterprise data

●

●

●

Configure desktop and server monitoring

●

●

●

Configure Cisco Unified Presence

●

●

●

Configure work flows

●

●

Configure CAD interface

●

●

Configure wrap-up data

●

●

●☛

●

Cisco Desktop Administrator

Cisco Work Flow Administrator

Configure integrated browser
Cisco Outbound Dialer

●

* CAD-BE only

12
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Related CAD Documentation
The following documents contain additional information about CAD 8.0:
■

Cisco CAD Installation Guide

■

Cisco Agent Desktop User Guide

■

Cisco Agent Desktop—Browser Edition User Guide

■

Cisco Supervisor Desktop User Guide

■

Cisco IP Phone Agent User Guide

■

Mobile Agent Guide for Cisco Unified CC Enterprise

■

Cisco CAD Service Information

■

Integrating CAD into a Thin Client Environment

.
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Getting Started with Cisco Desktop
Work Flow Administrator

1

Introduction
Desktop Work Flow Administrator allows only one person to view and/or edit data in it
at any one time. If someone is using Desktop Work Flow Administrator when you try to
access it, an error message appears that identifies the IP address of the other user’s
computer.
For this reason, it is important that you close Desktop Work Flow Administrator
completely when you are done using it. As long as the application is running, a license
is being used and others are blocked from accessing it.

March 1, 2013
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Starting Desktop Work Flow Administrator
To start Desktop Work Flow Administrator:

1. Click Start > Programs > Cisco > Desktop > Admin. Desktop Work Flow
Administrator starts.
2. Click the Call Center 1 node to expand the navigation tree. By default,
Desktop Administrator is not password-protected and the tree will expand. If a
password is configured, Desktop Administrator will prompt you for it now.
For more information about passwords, see "Configuring Passwords" on
page 21.

16
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Automated Updates

Automated Updates
CAD can be configured during installation so that every time you start Desktop Work
Flow Administrator, the software checks to see if there is an updated version
available. If there is, the software automatically runs the update process.
When the update process runs, a dialog box appears, stating that your copy of
Desktop Work Flow Administrator will be updated. Click OK and then follow the
instructions in the series of dialog boxes that follows. After the update finishes, a final
dialog box appears, stating that your update is complete. Click OK, and restart
Desktop Work Flow Administrator.
NOTE: To ensure that automated updates function correctly, you
must configure Internet Explorer so that it checks for newer versions
of stored pages. To configure this setting, launch Internet Explorer
and choose Tools > Internet Options. In the Browsing history section
on the General tab, click Settings. Select the option labeled Every
time I visit the web page.

March 1, 2013
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The Desktop Work Flow Administrator
Interface
The Desktop Work Flow Administrator interface has two panes. The left pane is a
navigation tree similar to that found in Windows Explorer. The right pane displays the
application that you choose in the left pane. Figure 1 shows the Desktop
Administrator interface with the Dial Strings node selected in the left pane and the
corresponding information displayed in the right pane.
Figure 1.

Desktop Work Flow Administrator interface

Toolbars and Menu Bars
When you select a node on the navigation tree, the Desktop Work Flow Administrator
menu bar and toolbar change to reflect the functionality of that node.

18
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The Desktop Work Flow Administrator Interface

The toolbar buttons you see are among those listed in Table 2.
Table 2.

Icon

Desktop Administrator toolbar buttons

Name

Description

About

Display copyright and version information.

Delete

Remove the selected work flow group.

Remove VoIP,
Recording/
Remove unneeded services from Directory Services.
Playback
Services
Help

Access Help files.

New

Add a new work flow group.

Properties

Display the URL of the selected subnode under the
Unified CCE Configuration node.

Web

Open a browser window and access the Cisco website.

Navigation Tree Pane
Use the following mouse actions to navigate the left pane.
■

Double-click an icon/application name to expand or collapse the tree.

■

Click the plus sign (+) to expand the tree.

■

Click the minus sign (–) to collapse the tree.

■

Right-click to delete a node (not available for all nodes).

Use the following keyboard actions to navigate the left pane. With a node selected:
■

Press the up and down arrow keys to move from one node to the next.

■

Press the left arrow key to collapse the tree.

■

Press the right arrow key to expand the tree.

Display Pane Navigation
The applications displayed in the right pane are designed to use shortcut keys and the
tab key as alternatives to using the mouse to navigate around a window. The shortcut
keys that apply to a specific node are discussed in the section devoted to that node’s
functions.

March 1, 2013
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User Privileges in Microsoft Windows
Because Desktop Work Flow Administrator users must be able to update registry
settings, they must have Administrator or Power User privileges on Microsoft Windows
platforms. See your Microsoft Windows documentation for information on managing
user privileges.

20
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Configuring Passwords

Configuring Passwords
You can use a password to protect both Desktop Work Flow Administrator and
Desktop Administrator. If you do not want Desktop Work Flow Administrator to be
password-protected, do not configure a password.

Configuring a Password in Desktop Work Flow
Administrator
A password is optional for Desktop Work Flow Administrator. If a password is
configured, when you select the contact center node you will be prompted to provide
the password before you can access any of the subnodes.
To set up password protection for Desktop Work Flow Administrator:

1. In the navigation pane, select the Call Center 1 node.
2. Choose Setup > Change Password. The Administrator Password dialog box
appears (Figure 2).
Figure 2.

Administrator Password dialog box

3. Leave the Old password field blank. Type a password in the New password
and Confirm new password fields, then click OK. Desktop Work Flow
Administrator is now password protected. You must restart the application to
make the change go into effect.

NOTE: Passwords are case sensitive and must consist of 1 to 32
alphanumeric characters.
To change your password for Desktop Work Flow Administrator:

1. In the left pane, select the Call Center 1 node.
2. Choose Setup > Change Password. The Change Password dialog box appears
(Figure 2).

March 1, 2013
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3. Type your current password in the Old password field. Type a new password in
the New password and Confirm new password fields, then click OK. Your
Desktop Administrator password is now changed. You must restart the
application for the change to go into effect.
To remove password protection from Desktop Work Flow Administrator:
When you remove password protection from Desktop Work Flow Administrator, you
automatically reset the password in Desktop Administrator to the default value, which
is blank.

1. In the left pane, select the Call Center 1 node.
2. Choose Setup > Change Password. The Change Password dialog box appears
(Figure 2).
3. Type your current password in the Old password field. Leave the New
password and Confirm password fields blank, then click OK.
4. You are asked to confirm that you want to leave Desktop Work Flow
Administrator unprotected. Click Yes. The Desktop Work Flow Administrator
password is removed. You must restart the application for the change to go
into effect.

Client Applications
User IDs, login names, and passwords are administered in Unified ICM for the
following applications:
■

Agent Desktop

■

CAD-BE

■

IP Phone Agent

A user’s password is verified on the CTI server when the user starts an application.

Agent Desktop, CAD-BE, and IP Phone Agent User ID, Login Name, and Password
Agent Desktop, CAD-BE, and IP Phone Agent user IDs, login names, and passwords
are set up in Unified ICM and can be administered only through Unified ICM. Use
Unified ICM to change a user’s Agent Desktop password if necessary.

Supervisor Desktop User ID, Login Name, and Password
A user’s Supervisor Desktop user ID and login name are the same as the user’s Agent
Desktop user ID and login name, and are set up in Unified ICM.
The first time Supervisor Desktop is started, the password is blank. It is up to the
supervisor to create a password using the Change Password functionality within
Supervisor Desktop.

22
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Configuring Passwords

The Supervisor Desktop password can be changed from within Supervisor Desktop or
from the Personnel node in Desktop Administrator (for more information, see
“Supervisors” in the Cisco CAD Installation Guide.

March 1, 2013
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Synchronizing Directory Services
The Directory Services database should be synchronized with the master Unified ICM
agent database. You can synchronize the agent database between Unified ICM and
Directory Services with the Synchronize Directory Services command.
By default, the database is synchronized once every 10 minutes. You can change the
synchronization interval by changing a setting in the DirAccessSynSvr.cfg file or you
can synchronize the databases manually.
To synchronize the databases manually:

1. In the left pane, select the logical contact center node.
2. Choose Setup > Synchronize Directory Services. When the synchronization is
complete, a message appears, stating that the synchronization was
successful.
NOTE: You can also manually synchronize Directory Services from
Desktop Administrator. See "Synchronizing Directory Services" on
page 159 for more information.

24
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Work Flow Configuration

2

Introduction
You can use Work Flow Configuration to configure and manage the appearance and
behavior of Agent Desktop, CAD-BE, and IP Phone Agent. Work Flow Configuration has
the following functions:
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■

Dial Strings (page 27)

■

Phone Books (page 39)

■

Reason Codes (page 46)

■

Wrap-up Data (page 50)

■

Record/Monitor Notification (page 55)

■

Work Flow Groups (page 57)
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To use a Work Flow Configuration function, select the corresponding node in the left
navigation pane in the Desktop Administrator window (Figure 3). The right pane
displays the options that can be configured for the selected node.
Figure 3.

Work Flow Configuration — Dial Strings node

The CAD client applications must be restarted for any configuration changes you make
to go into effect.
NOTE: When configuring the name or ID of objects (examples are
work flow groups, work flows, agent login names, server names, and
macro names), do not use the “=”character. This can cause problems
when backing up and restoring data.

26
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Dial Strings
Use the Dial Strings function to configure the way desktop applications display and
dial phone numbers.
NOTE: CAD-BE dial strings are not configurable.
First, select the appropriate check box at the bottom of the Dial Strings pane to
choose the dial string format you will use. You must select one check box. The
following formats are available.
■

North American Dial String Formatting (page 27)

■

Variable Length Dial String Formatting (page 35)

Different tabs are available, depending on the check box you select.

North American Dial String Formatting
If you choose North American dial string formatting, the following tabs are available.

March 1, 2013

■

Telephone Number Display (page 28)

■

Outgoing Calls (page 29)

■

Miscellaneous (page 34)
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Telephone Number Display
Use the Telephone Number Display tab (Figure 4) to configure the format that Agent
Desktop uses to display phone numbers. The selections you make are illustrated in
the sample fields, with the exception of the “Remove first ‘n’ digits” and “Remove last
‘n’ digits” fields. If you type non-zero values in one or both of these fields, the sample
does not change.)
Figure 4.

Telephone Number Display tab

Table 3 describes the sections on the Telephone Number Display tab.
Table 3.

Telephone Number Display tab — description

Section

Description

External number format

The format of the calling number and called number.

Area code/Exchange

The separator between area code and exchange.

Exchange/Subscriber code

The separator between exchange and subscriber
code.

Internal number format

The number of digits displayed for internal phone
numbers. You can also add a leading ‘x’ (extension).

To configure the telephone number display:
■

28

Select or clear the check boxes and radio buttons on the Telephone Number
Display tab as desired, then click Apply to save your changes.
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Outgoing Calls
Use the Outgoing Calls tab (Figure 5) to configure local area codes and exchanges.
Figure 5.

Outgoing Calls tab

Table 4 describes the sections and options on the Outgoing Calls tab.
Table 4.

Outgoing Calls tab — description

Section/option

Description

Local area code

The local 3-digit area code.
NOTE: If you must dial the area code for local calls,
leave this field blank.

Advanced Dialing…

Configure Advanced Internal Dialing and Advanced
External Dialing.

Prefixes

March 1, 2013

Local line access code

The number needed to access an outside local line.

Long distance line
access code

The number needed to access an outside long
distance line.

Ensure a 1 on long
distance calls

Automatically dial a “1” before dialing a long
distance phone number.
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Table 4.

Outgoing Calls tab — description (cont’d)

Section/option

Description

Use area code for toll calls
within the area code

Automatically dial the local area code before dialing
any numbers that are not in the local exchange list.

Use area code for local
calls

Automatically dial the local area code before dialing
any numbers in the local exchange list.

Local exchanges

To create a list of exchanges for which it is NOT
necessary to dial “1” first, click Add. Alternatively,
select the All exchanges are local check box.

To configure outgoing calls:
■

Enter information and select or clear the appropriate check boxes on the
Outgoing Calls tab as desired, then click Apply to save your changes.

Advanced Internal Dialing
Use the Advanced Internal Dialing tab on the Advanced Dialing Plan window (Figure 6)
to configure additional internal dialing options. To access this window, click Advanced
Dialing on the Outgoing Calls tab.
Figure 6.

30

Advanced Dialing Plan — Advanced Internal Dialing tab
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Table 5 describes the sections on the Advanced Internal Dialing tab.
Table 5.

Advanced Internal Dialing tab — description

Section

Description

Extensions

The maximum number of digits in an internal extension
number, from 1–12.
NOTE: If you select 7, you must specify the internal
exchange and the corresponding range of subscriber
numbers, so that the application can distinguish
between a 7-digit internal phone number and a 7-digit
outgoing call.

7-digit extensions:

(Available only if you select 7 or more as the maximum
number of digits for internal extensions.)

Exchange

The internal exchange.

Range of subscriber
numbers

The range of subscriber numbers from low to high that
correspond to the selected exchange.

To configure advanced internal dialing options:

1. Select the maximum number of digits used for internal extensions.
2. If you select 7 or more as the maximum number of digits for internal
extensions, complete the following steps.
a. Type a number in the Exchange field.
b. Type the first number in the Range of subscriber numbers field.
c. Type the last number in the To field.
d. Click Add.
e. Repeat steps a through d for each additional exchange used.
3. Click OK to save your changes and close the Advanced Dialing Plan window.

March 1, 2013
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Advanced External Dialing
Use the Advanced External Dialing tab on the Advanced Dialing Plan window to
configure additional external dialing options (Figure 7). To access this window, click
Advanced Dialing on the Outgoing Calls tab.
Figure 7.

Advanced External Dialing tab

Table 6 describes the sections on the Advanced External Dialing tab.
Table 6.

32

Advanced External Dialing tab — description

Section

Description

Neighboring area
codes with local
dialing privileges

The area codes to which you can place toll-free calls.

Exchanges for
7-digit local
numbers

The exchanges within a selected area code that do not require
‘1’ or an area code. Available only if you enter one or more
neighboring area codes.

Exchanges for
10-digit local
numbers

The exchanges within a selected area code that require an
area code but not ‘1’. Available only if you enter one or more
neighboring area codes.

March 1, 2013

Dial Strings

To configure advanced external dialing options:

1. Type a number in the Neighboring area codes field, then click Add.
2. If appropriate, complete one of the following steps.
■

If there are no exchanges within the neighboring area code that you
entered in step 1 that require ‘1’ or an area code, select the All exchanges
as 7-digit numbers check box.

■

If all exchanges within the neighboring area code that you entered in
step 1 require an area code but not ‘1’, select the All exchanges as
10-digit numbers check box.

3. If the neighboring area code that you entered in step 1 has one or more
exchanges that do not require ‘1’ or an area code, type the numbers in the
Exchanges for 7-digit local numbers field, then click Add.
4. If the neighboring area code that you entered in step 1 has one or more
exchanges that require an area code but not ‘1’, type the numbers in the
Exchanges for 7-digit local numbers field, then click Add.
5. Repeat step 1 through step 4 for each neighboring area code that you wish to
configure.
6. Click OK to save your changes and close the Advanced Dialing Plan window.

March 1, 2013
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Miscellaneous
Use the Miscellaneous tab to set up additional dialing properties (Figure 8).

NOTE: This tab is the same for North American and variable length
dial string formatting.
Figure 8.

Miscellaneous tab

Table 7 describes the options on the Miscellaneous tab.
Table 7.

34

Miscellaneous tab — description

Options

Description

Use text from the clipboard
as the phone number when
pressing the call button

Enable Agent Desktop to use clipboard text as the
dialed number when the Call button is pressed, as
long as the clipboard text is a valid text string.

Show the dial pad when
using text from the
clipboard for dialing.

Display the dial pad before dialing a number from
the clipboard. If unselected, Agent Desktop dials the
number without displaying the dial pad. Available
only if “Use text from the clipboard…” is selected.

March 1, 2013
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Table 7.

Miscellaneous tab — description (cont’d)

Options

Description

Convert text to digits in
phone numbers

Converts phone numbers expressed in alphabetic
characters (for example, 1-800-ANYWORD) to their
numeric equivalents before dialing.

To configure the miscellaneous options:
■

Select or clear the appropriate check boxes on the Miscellaneous tab as
desired, and then click Apply to save your changes.

Variable Length Dial String Formatting
If you choose variable length dial string formatting, the following tabs are available.
■

Telephone Number Display (page 28)

■

Phone Number Format (page 37)

■

Advanced Internal Dialing (page 30)

Telephone Number Display
Use the Telephone Number Display tab to configure the way Agent Desktop displays
phone numbers (Figure 9).
The selections you make are illustrated in the sample fields, with the exception of the
“Remove first ‘n’ digits” and “Remove last ‘n’ digits” fields. If you type non-zero values
in one or both of these fields, the sample does not change.)

March 1, 2013
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NOTE: The number of digits displayed in each section of the sample
phone number is for illustration only. The samples do not reflect the
number format you set up on the Phone Number Format tab.
Figure 9.

Telephone Number Display tab

Table 8 describes the sections on the Telephone Number Display tab.
Table 8.

Telephone Number Display tab — description

Section

Description

External number format

The format of the calling and called numbers.

City/subscriber code

The separator between the city and subscriber codes.

Internal number format

The number of digits displayed for internal phone
numbers. You can also add a leading ‘x’ (extension).

To configure the telephone number display:
■

36

Enter data and select or clear the appropriate check boxes and radio buttons
as desired, then click Apply to save your changes.
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Phone Number Format
Use the Phone Number Format tab (Figure 10) to configure the format for phone
numbers that do not use North American dial string formatting. You can also set the
maximum number of digits in an internal phone extension. You can establish as many
formats as you want, as long as each format has a unique total length.
Figure 10.

March 1, 2013

Phone Number Format tab
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To add a new phone number format:

1. Click Add. The Add City/Subscriber Code Lengths dialog box appears.
Figure 11.

Add City/Subscriber Code Lengths dialog box

2. Type the number of digits for city codes and subscriber codes, then click OK.
The numbers you entered are displayed in the phone number format pane,
with the calculated total length of the format.
NOTE: You cannot enter another format with the same total length.
3. When you are finished adding formats, click Apply. The new phone number
format is saved.
To edit a phone number format:

1. Select a number format, then click Edit. The Edit City/Subscriber Code
Lengths dialog box appears.
2. Make your changes, then click OK.
3. Click Apply to save your changes. The phone number format is changed.
To delete a phone number format:

1. Select a number format, then click Delete.
2. Click Apply to save your changes. The phone number format is deleted.

Miscellaneous
The Miscellaneous tab for variable length dial string formatting is the same as the
Miscellaneous tab for North American dial string formatting.
See "Miscellaneous" on page 34 for a description of the Miscellaneous tab.
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Phone Books
Agents have the following types of phone lists available to them.
■

The Recent Call List, a dynamic list of up to 100 recently called phone
numbers kept by Agent Desktop

■

A personal phone book with a maximum of 3,000 entries, created and
maintained by the agent (and enabled/disabled by the administrator)

■

Global phone books, each with a maximum of 3,000 entries, created by the
administrator with the global Phone Book function

■

Work flow group phone books, each with a maximum of 3,000 entries,
created by the administrator with the work flow group Phone Book function

The maximum number of phone books (global and work flow group) is 256. The
system can support no more than 10,000 total phone book entries (global, personal,
and work flow group phone books).
Global phone books are created and maintained using the Phone Book node under
the Work Flow Configuration application. Work flow group phone books are created
and maintained using the Phone Book node under the specific work flow group node
(Figure 12).
Figure 12.

Global and work flow phone book nodes

Global phone
book

Work flow
group phone
book
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Use the global phone book (Figure 13, left) to create and manage the global phone
books that are shared by all agents.
Use the work flow group phone book (Figure 13, right) to create and manage the work
flow group phone books that are shared by agents in specific work flow groups.
Phone books and phone book entries are created and maintained in the Phone Book
Editor dialog box (see "Creating Phone Books" on page 41).
Figure 13.

Phone Book window

Global level

Work flow group level

Using the Phone Book Filter
You can use the phone book filter to find phone book entries more easily. The filter
enables you to limit the entries listed in the phone book window. You can use any of
the four phone book fields to filter the entries.
To use the phone book filter:

1. In the Phone Book window, select the Filter check box.
2. From the Filter drop-down lists, select how you want to filter the entries. In the
first two drop-down lists, select your filter criteria: the field to filter by, and the
filter method. In the third field, enter the filter string.
For example, if you want to see all phone book entries for persons whose last
name begins with “J”, select “Last Name” from the first drop-down list,
“Begins with” from the second drop-down list, and enter J in the third field.
The alter operates as soon as you enter your filter string in the third field.
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3. To stop filtering the phone book, clear the Filter check box or delete the filter
string in the third field. The entire phone book will once again be visible.

Creating Phone Books
To set up a new phone book:

1. In the global or work flow group phone book window, click Edit. The Phone
Book Editor window appears (Figure 14).
Figure 14.

Phone Book Editor window

2. Type a name for the new phone book in the Phone Books field, then click Add.
The new phone book is added to the list of phone books.
3. Click OK. The new phone book is saved and the Phone Book Editor window
closes.
To add phone book entries:

1. In the Phone Book window, select a phone book from the drop-down list, then
click Edit. The Phone Book Editor window appears.
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2. Enter a name, phone number, and note for a person or company, then click
Add to add the information to the phone book. The minimum amount of
information required for a phone book entry is the phone number.
NOTE: The Phone Number field allows only numbers (0-9), letters (aA-zZ),
spaces, and the characters ‘ ( ) + ; / : . = ?.
If you enter any other character you are advised you used a disallowed
character. The disallowed character will be replaced by a question mark so
you can change it to an allowed character.
3. Repeat Step 2 as needed to enter all entries to the phone book. When you are
done adding entries, click OK. Your entries are saved and the Phone Book
Editor window closes.
To edit phone book entries:

1. Navigate to the global or work flow group phone book node.
2. Select a phone book from the drop-down list, then click Edit. The Phone Book
Editor window appears.
3. Select an entry in the phone book, then complete one of the following steps.
■

To modify the entry, click Edit.

■

To delete the entry, click Delete.

4. When you are done editing entries, click OK. Your changes are saved and the
Phone Book Editor window closes.

Enabling or Disabling Phone Books
Phone books can be enabled or disabled only on the global level.
To disable phone books:

1. Navigate to the global phone book node.
2. If you wish to remove agent access to all global and work flow group phone
books, select the Disable all phone books check box.
3. If you wish to remove agent access to all personal phone books, select the
Disable personal phone book check box.
NOTE: All agents must log out and close Agent Desktop in order for
the disabling of phone books to take effect.
4. Click Apply.
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To enable phone books:

1. Navigate to the global phone book node.
2. If you wish to add agent access to all global and work flow group phone books,
clear the Disable all phone books check box.
3. If you wish to add agent access to all personal phone books, clear the Disable
personal phone book check box.
4. Click Apply.

Importing and Exporting Phone Books
Importing and exporting phone books makes creating and maintaining large phone
books (up to 3000 entries) easier than with the Phone Book Editor window. Phone
books can be created and edited in any third-party application that accepts
comma-separated value (CSV) files, such as a text editor or spreadsheet. Using the
third-party application, you can edit exported phone books—make bulk changes (for
example, changing an area code), and adding and deleting phone numbers. The
updated file can then be imported into Desktop Work Flow Administrator to replace
the previous version.
NOTE: Phone books for double-byte languages must use UTF-8
character format in order for the double-byte characters to be
imported successfully.

CSV File Format
The phone book CSV file contains the fields shown inTable 9.
Table 9.

Phone book CSV file details

Field

Max Length

Permitted Characters

Can Be
Blank?

First Name

100

Any printable

No

Last Name

100

Any printable

No

Phone Number

40

0–9, aA–zZ, ‘ ( ) + / : . = ?

No

Notes

256

Any printable

Yes

An example of a phone book CSV file is shown below.
"First Name","Last Name","Phone Number","Notes"
"Amanda","Cohen","6511234",""
"Nicholas","Knight","612-555-1228","Sales"
"Natalie","Lambert","952-555-9876","Benefits"
"Joseph","Stonetree","651-555-7612","Manager"
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A phone book CSV files must conform to this format and include the headers in the
first line. During import the file is scanned for illegal characters. If any are found, they
are replaced with question marks.
NOTE: Exported CSV files will always show each field enclosed in
double quotes, as in the example above. This is to ensure that any
commas or double quotes that are part of the actual field data are
not mistaken for field delimiters. If your data does not include these
characters, you can omit the double quotes in files you prepare for
importing.
To import a phone book:

1. Make sure the phone book CSV file is formatted correctly, as specified in the
section, "CSV File Format" on page 43.
2. In the Phone Book window, click Edit. The Phone Book Editor window appears
(Figure 14 on page 41).
3. Click Import. The Import Select dialog box appears (Figure 15).
Figure 15.

Import Select dialog box

Any CSV files located in the default folder
C:\Program Files\Cisco\Desktop\config are listed. If your file is located
somewhere else, click Find folder to browse to its location.
4. Select the file you want to import and then click OK. The phone book is
imported and is added to the list of available phone books in the Current List
pane.
The CSV file name (without the CSV suffix) becomes the phone book name. If
that name is already in use, you will be asked if you want to replace the
existing phone book with the imported phone book. If you do not want to
replace the existing phone book, cancel the import, rename the CSV file, and
try again.
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5. Click OK to close the Phone Book Editor window.
To export a phone book:

1. In the Phone Book window, click Edit. The Phone Book Editor window appears
(Figure 14 on page 41).
2. In the Current list pane, select the phone book you want to export, and then
click Export. The Export Phone Book dialog box appears (Figure 16).
Figure 16.

Export Phone Book dialog box

3. The default export location is the C:\Program Files\Cisco\Desktop\config
folder. If you have imported or exported a phone book previously, the location
you chose then is shown. If you want to export the phone book to a different
location, click Browse to a different folder and navigate to that location.
4. Click OK. The phone book is exported to the selected location. The file name
is the name of the phone book with the CSV file extension.
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Reason Codes
Reason codes describe why an agent has changed to the Not Ready agent state or
has logged out.
There is no limit on how many reason codes can be configured and displayed in Agent
Desktop and CAD-BE. There is no limit to how many reason codes can be configured
for IP Phone Agent, but IP Phone Agent can display only 100 reason codes.
NOTE: It is recommended as a best practice that you configure no
more than 20 reason codes for agents to use.
Reason codes are set up and maintained in Unified ICM using the Cisco Unified
Contact Center Enterprise Web Administration Tool (if you use System IPCC) or
Unified ICM Configuration Manager (if you use anything other than System IPCC, for
example, Unified ICM Enterprise/Hosted or Unified CC Enterprise/Hosted). You use
Desktop Administrator to assign reason codes to agents on both a global and work
flow group level.
Global reason codes are assigned using the Reason Codes node under the Work Flow
Configuration node. Work flow group reason codes are assigned using the Reason
Codes node under the specific work flow group node (Figure 17).
Figure 17.

Global and work flow reason code nodes

Global
Reason
Codes 
node

Work flow
group
Reason
Codes
node
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Global reason codes are available for use by all agents. Work flow reason codes are
available only to those agents in that specific work flow group.
Reserved reason codes are predefined in LDAP and cannot be created or deleted.
These reason codes are automatically applied to events over which agents have no
control, such as being logged out by a supervisor or because of a system failure. They
are not visible to the agent, but appear only in reports and in the global Reason Codes
window.
NOTE: It is recommended that reason codes created in Unified ICM
do not use the same reason code numbers as the reserved reason
codes. If there are duplicated reason code numbers, errors in
reporting and other problems might result.
Table 10 lists the reserved reason codes.
Table 10.

Reserved reason codes

Reason Code

Description

-3

Extension modified while logged in

-2

PG failure

-1

Peripheral restarted

22

Supervisor logout

33

Supervisor not ready

20001

Not Ready for force logout

20002

Force logout

20003

Not Ready for logout

32767

Ring no answer

50001

CTI OS disconnect

50002

CTI OS component disconnect

50003

Device out of service

50004

Agent inactivity

50010

Routed call NOT delivered

50020

Agent Re-skill

Not Ready and Logout reason codes are enabled or disabled on the work flow group
level.
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NOTE: You can configure reason codes within the Cisco Unified
Contact Center Enterprise Web Administration Tool (if you use System
IPCC) or the Unified ICM Configuration Manager (if you use anything
other than System IPCC) so that they are required when logging out or
going to the Not Ready state. However, Agent Desktop cannot detect
these settings. It is recommended that the enterprise desk settings
“Idle reason required” and “Logout reason required” be left
unselected and that the enabling or disabling of reason codes be
done within Desktop Administrator.
NOTE: Agents must restart Agent Desktop, CAD-BE, and IP Phone
Agent to see any changes you make to reason codes.
NOTE: Depending on whether the agent’s IP phone has UTF-8
support for double-byte languages, reason codes in IP Phone Agent
might not display correctly. See the Cisco CAD Installation Guide for
more information on language support for IP Phone Agent.

Assigning Reason Codes
To assign global reason codes:

1. Select the global Reason Codes node in the navigation tree to display the
Reason Codes window (Figure 18, left).
Figure 18.

Reason Code window — global (left) and work flow group (right)

2. Select the appropriate tab for the type of reason codes you want to assign:
Logout or Not Ready.
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3. From the Available Reason Codes List, select the reason codes you want
available to all agents, and then click the right arrow button to move them to
the Global Reason Codes List.
4. Click Apply.
To assign work flow reason codes:

1. Select the Reason Codes node under the desired work flow group in the
navigation pane to display the Reason Codes window (Figure 18, right).
2. Select the appropriate tab for the type of reason codes you want to assign,
Logout or Not Ready.
3. From the Available Reason Codes List, select the reason codes you want
available to agents in that work flow group, and then click the right arrow
button to move them to the Work Flow Group List.
4. Select the Enable Logout Reason Codes or Enable Not Ready Reason Codes
check box to enable that type of reason code for the agents in that work flow
group. This includes any global reason codes set up.
5. Click Apply.

Enabling or Disabling Reason Codes
Reason codes can be enabled or disabled only on the work flow group level, and must
be done individually for every work flow group.
To enable or disable reason codes:

1. Select the Reason Codes node under the work flow group whose reason
codes you want to enable or disable.
2. Select the appropriate tab and then select or clear the Enable Logout Reason
Codes or Enable Not Ready Reason Codes check box.
3. Click Apply.
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Wrap-up Data
Wrap-up data descriptions are used by contact centers for purposes such as tracking
the frequency of different activities and identifying the account to which to charge a
call, among others. Wrap-up data is set up and maintained, and automated state
changes are enabled, using the Wrap-up Data window.
There is no limit on how many wrap-up descriptions can be configured and displayed
in Agent Desktop and CAD-BE. There is no limit to how many wrap-up descriptions can
be configured for IP Phone Agent, but IP Phone Agent can display only 100 wrap-up
descriptions.
NOTE: Agent Desktop and CAD-BE agents must log out, exit, and
restart the application for changes to take effect.
Global wrap-up data descriptions are created and assigned using the Wrap-up Data
under the Work Flow Configuration node. Work flow group wrap-up data descriptions
are created and assigned using the Wrap-up Data node under the specific work flow
group node (Figure 19).
Figure 19.

Global and work flow group wrap-up data

Global
Wrap-up
Data node

Work flow
group
Wrap-up
Data node

In Agent Desktop, CAD-BE, and IP Phone Agent, the agent selects the appropriate
wrap-up data description at the beginning of the wrap-up work time for a call. The
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value that the agent selects appears in the Termination_Call_Detail record for the call
in the Unified ICM database.
IP Phone Agent is limited to a maximum of 100 wrap-up data descriptions.
To enable Desktop Administrator to properly manage wrap-up data, you must
configure the following Enterprise Desk Settings options in Unified ICM Configuration
Manager as optional:
■

Work mode on Incoming

■

Work mode on Outgoing

Within Unified ICM Configuration Manager, you can configure wrap-up data so that it is
required when transitioning to the Work Ready or Work Not Ready states. However,
Agent Desktop cannot detect these settings. Leave the Unified ICM Configuration
Manager settings as optional and enable or disable wrap-up data within Desktop
Administrator.
When creating wrap-up data descriptions, follow these guidelines:
■

Descriptions can consist of up to 39 alphanumeric characters. No
punctuation or other characters are allowed.
NOTE: Depending on whether the agent’s IP phone has UTF-8
support for double-byte languages, wrap-up descriptions in IP Phone
Agent might not display correctly. See the Cisco CAD Installation
Guide for more information on language support for IP Phone Agent.

■

Duplicate descriptions are not allowed.

Creating Wrap-up Data Descriptions
Contact centers use wrap-up data for numerous reasons, such as tracking the
frequency of specific activities or identifying accounts to which calls should be
charged. If wrap-up data is enabled, whenever an agent changes agent state to Work
Ready or Work Not Ready immediately after a call terminates, the agent chooses the
appropriate wrap-up data description from a popup dialog box.
You can create and modify wrap-up data descriptions on both the global and work flow
group level.

March 1, 2013

51

Cisco Desktop Administrator User Guide

To create a wrap-up data description:

1. Select the global or work flow group Wrap-up Codes node in the navigation
tree to display the Wrap-up Codes window (Figure 20).
Figure 20.

Wrap-up Data window — global (left) and work flow group (right)

2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 21).
Figure 21.

Wrap-up Data Editor dialog box

3. Type the new wrap-up data description in the Description field, then click Add.
The wrap-up data description is added to the Wrap-up Data list.
4. Click OK close the dialog box, then click Apply to save your changes.
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To edit a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree
to display the Wrap-up Data window (Figure 20).
2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 21).
3. Double-click the wrap-up data description you want to edit.
4. In the popup dialog box, edit the description as desired and then click OK.
5. Click OK to close the Wrap-up Data Editor dialog box, then click Apply to save
your changes.
To delete a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree
to display the Wrap-up Data window (Figure 20).
2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 21).
3. Select the wrap-up data description you want to delete, then click Delete.
4. Click OK to close the dialog box, then click Apply to save your changes.

Assigning Wrap-up Data Descriptions
Wrap-up data descriptions can be assigned at the global and at the work flow group
level. Global wrap-up data descriptions are available to all agents. Work flow group
level wrap-up data descriptions are available only to the agents in that specific work
flow group.
To assign global wrap-up data descriptions:

1. Select the global Wrap-up Data node in the navigation tree to display the
Wrap-up Data window (Figure 20, left).
2. From the Available Wrap-up Descriptions list, select the descriptions you want
available to all agents, then click the right arrow button to move them to the
Global Wrap-up Descriptions list.
3. Click Apply.
To assign work flow wrap-up data descriptions:

1. Select the Wrap-up Data node under the desired work flow group in the
navigation pane to display the Wrap-up Data window (Figure 20, right).
2. From the Available Wrap-up Data list, select the descriptions you want
available to agents in that work flow group, and then click the right arrow
button to move them to the Work Flow Wrap-up Data list.
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3. Select the Enable Wrap-up Data check box to enable wrap-up data for the
agents in that work flow group. This includes any global wrap-up data
descriptions set up.
4. Click Apply.

Enabling or Disabling Wrap-up Data
Wrap-up data can be enabled or disabled only on the work flow group level.
To enable or disable wrap-up data:

1. Select the Wrap-up Data node under the work flow group whose wrap-up data
descriptions you want to enable or disable.
2. Select or clear the Enable Wrap-up Data check box.
3. Click Apply.

Automatic State Changes
If automatic state changes are enabled, agents are automatically changed from the
Work Not Ready state to the Not Ready state, and from the Work Ready state to the
Ready state, when they enter wrap-up data.
Automatic state changes can be enabled or disabled only on the work flow group level.
NOTE: It is possible to set a timer in Unified ICM that will override the
automatic state change. If an agent doesn’t enter wrap-up data within
the time set by the timer, the system will change the agent’s state to
the next state (Not Ready or Ready) and close the Wrap-up Data
dialog box without anything being entered.
To enable or disable automatic state changes:

1. Select the Wrap-up Data node under the work flow group whose automatic
state changes you want to enable or disable.
2. Select or clear the Enable Automatic State Change check box.
3. Click Apply.

54

March 1, 2013

Record/Monitor Notification

Record/Monitor Notification
The Record/Monitor Notification window is used at the global level to enable or
disable messages to agents that they are being recorded or monitored, or both, and to
enable or disable supervisors’ ability to barge in and intercept agent calls.
Figure 22.

Record/Monitor Notification window

To enable or disable supervisor barge-in/intercept and notification:

1. Select the Record/Monitor Notification node in the navigation tree.
2. In the Record/Monitor Notification window, select or clear the Enable Barge
In/Intercept, Notify Monitoring, and/or Notify Recording check boxes, then
click Apply.
NOTE: By default, barge in/intercept is enabled, and monitoring and
recording notification is disabled.
You can also enable/disable monitoring notification and recording notification from
the menu bar.
1. Select the Work Flow Configuration node or any of its subnodes in the
navigation tree.
2. From the menu bar, choose Monitoring.
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3. Choose Notify Monitoring and/or Notify Recording from the menu. A check
mark appears next to the option when it is enabled.
Figure 23.
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Work Flow Groups
Use the Work Flow Groups function to create and configure agent work flow groups.
Figure 24.

Accessing Work Flow Group functions in the navigation tree

p

Under the Work Flow Groups node are individual work flow groups. Initially there is a
default work group, which can be edited, renamed, or deleted. You can also create
additional work flow groups.
When you click on a work flow group, the elements that make up that work flow group
appear as subnodes:
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■

Enterprise Data. Configure enterprise data on the agent desktop for the
selected work flow group.

■

Reason Codes. Assign reason codes for the selected work flow group.

■

Wrap-up Data. Create and edit wrap-up data for the selected work flow group.

■

Phone Book. Create and edit phone books for the selected work flow group.
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■

CAD Agent. Configure the user interface, voice contact work flows, and agent
management work flows for agents who use Agent Desktop.

■

CAD-BE Agent. Configure the user interface and voice contact work flows for
agents who use CAD-BE.

■

IP Phone Agent. Enable agent-initiated recording for agents who use the
IP Phone Agent service.

Maintaining Work Flow Groups
You can add, delete, or edit work flow groups under the Work Flow Groups node.
NOTE: If you choose to delete the default work flow group, make sure
that all agents are assigned to a custom work flow group you have set
up. If an agent is not assigned to a work flow group, and there is no
default work flow group, that agent will not be able to start Agent
Desktop.
To add a new work flow group:

1. In the Navigation tree, select the Work Flow Groups node.
2. Choose File > New, or click New on the toolbar. The Work Flow Group Name
Editor dialog box appears.
Figure 25.

Work Flow Group Name Editor dialog box

3. Enter a new work flow group name. If you want to copy an existing work flow
group, select the Copy the following work flow group check box and choose a
work flow group from the drop-down list.
4. Click OK. The new work flow group appears in the Navigation pane under the
Agents node.
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To delete an existing work flow group:

1. In the Navigation pane, select the work flow group you want to delete.
2. Choose File > Delete, or click Delete on the toolbar. A message appears,
stating that all agents who belong to the work flow group you want to delete
must be reassigned to other work flow groups. Click Yes to confirm the
deletion, or No to cancel it. If you do not reassign the agents, you will not be
able to delete the work flow group.
3. Click OK to close the dialog box.
You cannot rename an existing work flow group directly. Instead, you must set up a
new work flow group and copy the existing work flow group’s settings to the new work
flow group.
To rename a work flow group:

1. Add a new work flow group, giving it the name you want to change the existing
work flow group’s name to.
2. Select the Copy the following work flow group check box and select the
existing work flow group from the drop-down list, and then click OK. The copy
process can take some time.
3. Delete the old work flow group.
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Enterprise Data
The Enterprise Data window enables you to complete the following tasks.
■

Configure Agent Desktop so that so that agents in the selected work flow
group can edit enterprise data

■

Set thresholds for call duration at a particular type of device while a call is in
the contact center

Data
The Data tab controls whether or not an agent in the work flow group is allowed to edit
the enterprise data displayed in Agent Desktop (Figure 26).
Figure 26.

Data tab

To enable enterprise data editing:
■

60

Select the Allow agent to edit Enterprise Data check box, and then click Apply.
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Call Activity
The Call Activity tab (Figure 27) enables you to set the thresholds for the selected work
flow group for call duration at a particular type of device (Route Point and Agent) while
a call is in the contact center.
If a call remains at a device longer than the defined Caution or Warning threshold, a
Caution or Warning icon is displayed next to the device name in the Agent Desktop call
activity pane.
Figure 27.

Call Activity tab

To set up call activity thresholds:

1. On the Call Activity tab, enter the threshold times as desired. The maximum
value for Warning is 59 minutes, 59 seconds. The maximum value for Caution
is 59 minutes, 58 seconds.
NOTE: Enter values in the Warning fields before entering values in the
Caution fields. Desktop Administrator will not accept data entered in
the Caution fields if no data appears in the Warning fields.
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NOTE: The Warning threshold value must be greater than the Caution
threshold value. If you enter a greater value in the Caution field,
Desktop Administrator automatically changes it so that it is one
second less than the Warning value.
2. Click Apply to save your changes.
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CAD, CAD-BE, and IP Phone Agent Nodes
The CAD Agent, CAD-BE Agent, and IP Phone Agent nodes enable you to configure
various functions for each type of agent within the selected work flow group.

CAD Agent Node
You can configure the following elements for agents who use Agent Desktop.
■

User Interface (page 64)

■

Voice Contact Work Flows (page 81)

■

Agent Management Work Flows (page 91)

CAD-BE Agent Node
You can configure the following elements for agents who use CAD-BE.
■

User Interface (page 64)

■

Voice Contact Work Flows (page 81)

IP Phone Agent Node
The Recording node under the IP Phone Agent node enables agent-initiated recording
for agents who use the IP Phone Agent service.
NOTE: If your CAD system is configured to use Cisco Unified
Communications Manager-based monitoring, the IP Phone Agent
node is not available.
When enabled, the IP Phone Agent service has soft key options for starting and
stopping recording. The IPPA agent can then record his or her own phone
conversations, and these recordings can be reviewed by the supervisor using
Supervisor Record Viewer.
See the Cisco IP Phone Agent User Guide and the Cisco Supervisor Desktop User
Guide for more information.
To enable IPPA agent-initiated recording:

1. Select the Enable IPPA Recording check box.
2. Click Apply to save your changes.
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User Interface
The User Interface window enables you to configure the appearance and behavior of
Agent Desktop (when accessed under the CAD Agent node) and CAD-BE (when
accessed under the CAD-BE Agent node).
NOTE: The User Interface windows for the CAD Agent and CAD-BE
Agent nodes are slightly different to allow for the differences in the
two applications. The following section discusses the CAD Agent node
and notes differences for the CAD-BE Agent node.

Toolbar
The Toolbar tab (Figure 28) enables you to complete the following tasks.
■

Adding and Removing Toolbar Buttons (page 65)

■

Associating Actions with Task Buttons (page 65)

■

Changing a Task Button’s Hint (page 66)

■

Customizing Button Icons (page 66)

■

Show Data Fields (page 68)

Figure 28.
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Toolbar tab — CAD Agent node (left) and CAD-BE Agent node (right)
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Adding and Removing Toolbar Buttons
The pane on the left of the Toolbar tab displays the buttons that are available to be
used on the Agent Desktop or CAD-BE toolbar. Buttons that are assigned show an icon
next to them; unassigned buttons do not show an icon.
You cannot change the hint or the shortcut key combination on any of the standard
buttons, or assign an additional action to them. You can, however, customize the icon
displayed on the button (see "Customizing Button Icons" on page 66).
To add a button to the toolbar:

1. In the list of buttons, select the available button you want to add.
2. Select the Visible check box, and then click Apply.
Removing a button from the toolbar:

1. In the list of buttons, select the button you want to remove.
2. Clear the Visible check box, and then click Apply.

Adding the Cisco Unified Outbound Dialer Toolbar
The Cisco Unified Outbound Dialer feature is available only for Agent Desktop users.
You cannot add the Outbound Dialer toolbar to CAD-BE.
For more information, see "Cisco Unified Outbound Dialer" on page 131.
To add the Outbound Dialer toolbar to Agent Desktop:
■

In the Outbound Dialer Mode section, check the type of dialing mode your
calling campaign will use, and then click Apply. You can select more than one
dialing mode check box. The appropriate buttons for that type of calling
campaign are added to the Agent Desktop toolbar.
NOTE: The Outbound Dialer Mode section appears on the Toolbar tab
only if Outbound Dialer is enabled in Unified ICM. If it is not enabled,
this section is blank.

Associating Actions with Task Buttons
You can associate as many actions with a task button as you wish. The actions are
executed sequentially in the order they are listed in the Actions window.
NOTE: Consider the length of time it takes to execute actions. A
maximum of two or three actions per task button is recommended.
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The default task buttons display icons of the numbers 1 through 10. You can
customize these icons if you wish.
To associate an action with a task button:

1. Select a task button from the list of available buttons.
2. Select the Visible check box. The Actions pane and associated buttons are
enabled.
3. Under the Actions pane, Click Add. The Select Action window appears.
4. Select the action you want to associate with the button. You can select an
existing action or set up a new action. For more information on setting up new
actions, see "Creating Actions" on page 95.
5. Click OK. The Toolbar tab is displayed.
6. Type a short description of the action in the Hint field. You can replace only
the hint; you cannot change the shortcut key combination.
7. Repeat Steps 3–6 if you want to add other actions to the same task button.
8. Click Apply to save your changes.

Changing a Task Button’s Hint
You can change the hint (the text an agent sees when the mouse hovers over a button)
associated with a task button. You cannot change the hint associated with a standard
button, or change the shortcut key combination of any button.
To change a task button’s hint:

1. Select the button whose hint you want to change.
2. In the Hint field, type the hint you want displayed to the agent.
3. Click Apply to save your changes.

Customizing Button Icons
Buttons can be customized by applying different icons to them. A library of available
icons is supplied with Desktop Administrator, or you can use icons of your own.
If you use your own icons, when an icon file is applied to a button it is written to
Directory Services so that it is available to all instances of Agent Desktop and CAD-BE.
Custom icons must meet the following specifications.
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■

ICO format

■

16 × 16 pixels or 32 × 32 pixels

■

Up to 256 colors

■

File size no more than 50,000 bytes
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To customize a button icon:

1. Select the button that has an icon you want to customize.
2. Click Customize Icon. The Choose Icon dialog box appears (Figure 29).
Figure 29.

Choose Icon dialog box

3. Select an icon. The icon is displayed in the Preview area. You can also click
Browse to navigate to another folder if you want to use your own icon.
4. Click OK. The new icon is displayed in the button list.
5. When you are finished, click Apply to save your changes.
To reset a button icon:

1. Select the button that has the icon that you previously customized. The Reset
button becomes enabled.
2. Click Reset. The original icon is displayed in the button list.
3. When you are finished, click Apply to save your changes.
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Show Data Fields
The Show Data Fields tab (Figure 30) allows you to rename and configure the data
fields that appear in the contact appearance pane in Agent Desktop and CAD-BE, and
enable/disable incrementing duration fields in CAD-BE.

NOTE: CAD-BE agents must log out, exit CAD-BE, and log in again for
changes to take effect.

Configuring and Renaming Data Fields
The left pane displays the fields that appear in Agent Desktop and CAD-BE. The right
pane displays the available fields.
NOTE: The left pane must contain at least one field.
To configure the data fields that appear:

1. Use the left and right arrows to move the available fields between the left and
right panes, and the up and down arrows to set the left-to-right order in which
the fields will appear.
2. Click Apply to save your changes.
Figure 30.
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Show Data Fields tab — CAD Agent (left) and CAD-BE Agent (right)
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To rename a data field:

1. Double-click the field you want to rename. The Rename dialog box appears
(Figure 31).
Figure 31.

Rename dialog box

2. Enter a new name, then click OK.

Show Duration
For CAD-BE agents, select the Show Duration check box to enable the Duration field in
CAD-BE to increment during a call. By default this option is enabled. However, a
continually changing field can cause difficulties for screen readers, so this field might
be disabled for agents who are visually impaired.
For Agent Desktop, the Show Duration feature is enabled/disabled on the Accessibility
Options tab in the Preferences window.
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Miscellaneous
Use the Miscellaneous tab (Figure 32) to configure other user interface options.
Select or check your desired settings, and then click Apply to save your changes.
Figure 32.
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Miscellaneous tab — CAD Agent (left) and CAD-BE Agent (right)
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Table 11 describes the options on the Miscellaneous tab.
Table 11.

Miscellaneous Tab options

Option

Description

Window Behavior

Specify how you want the Agent Desktop window to behave.
The default setting is Agent’s Choice.
• Normal. The window appears when calls are present
and minimizes when idle.
• Keep Open. The window is always visible, but can be
hidden by other open applications.
• Always on Top. The window is always visible and on top
of other open applications.
NOTE: When you select the Always on top
window behavior, you cannot select the real
time displays and dial pad always on top
options.
• Stealth. The window appears as an icon in the system
tray.
• Agent’s Choice. Behavior is set locally by the agent. The
local setting persists until reset or until you choose
something other than Agent’s Choice. On the agent’s
desktop, the default setting is Normal.

Window Options*

Select to keep the Real time displays and dial pad always on
top. The window remains open when idle and on top of all
other open applications.

Macro Hot Key

Specify the key you want to use to pause macro recording
and display the Suspend Macro Recording dialog. The
default is F2.

Rules and Actions
only apply to the
first call appearance

Select to invoke rules processing only for the oldest (top)
call appearance. If the check box is not selected, rules
processing is invoked for all inbound calls.

* If both real time displays and dial pad options are selected to be always on top, the most recent of
the two windows an agent open will be on top.

Browser Setup
Use the Browser Setup tab (Figure 33) to configure the Integrated Browser portion of
Agent Desktop. On this tab you can:
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■

Enable/disable the integrated browser window

■

Set the default web page displayed by the browser

■

Enable up to 10 browser tabs

■

Enable/disable popups to be displayed as a regular Internet Explorer popup
window instead of as a new tab in the integrated browser

■

Enable/disable agents’ access to other websites

■

Add work sites (or “favorites”) so agents can quickly access frequently-used
websites

Figure 33.

Browser Setup tab — CAD Agent (left) and CAD-BE Agent (right)

Enabling the Integrated Browser
Enable or disable the integrated browser in Agent Desktop/CAD-BE by selecting or
clearing the Enable Integrated Browser check box.

Enabling Access to Other Websites
Enable or disable an agent’s access to other websites by selecting or clearing the
Allow Address Editing check box. When selected, the Address field appears in the
integrated browser window, and agents can enter the URL of a website they wish to
view. When deselected, the Address field does not appear in the integrated browser
window.
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Enabling Hyperlink Dialing
Select the Enable Hyperlink Dialing check box to enable Agent Desktop to dial phone
numbers on websites displayed in the integrated browser when clicked (“click to dial”).
The phone numbers that can be dialed in this manner must conform to the following
rules:
NOTE: Hyperlink dialing is not available for CAD-BE.

Configuring the Number of Browser Tabs
Choose 0 to 10 in the Number of Workflow Browsers field to set how many browser
tabs appear in Agent Desktop (this feature is not available in CAD-BE). If you choose 0,
only the supervisor push page tab appears—it is always enabled. If you choose
1 to 10, that many tabs in addition to the supervisor push page tab appear.
Work flow HTTP actions can be set up to display web pages in a specific browser tab.
See "Creating HTTP Actions" on page 106 for more information.

Enabling Popus to be Displayed in a New Window
You can enable/disable popups to be displayed as regular Internet Explorer popup
windows in Agent Desktop by selecting or clearing the Popups in New Windows check
box. If this check box is not enabled, popups are displayed as new tabs in the
integrated browser.
NOTE: If popups are enabled, an administrator cannot control the
resulting Internet Explorer window. The agnet might be able to gain
full naviational control of the resulting browser window, including the
address bar.

Setting Up the Home Page
A home page is the website that appears in an integrated browser tab when Agent
Desktop is started. The default home page is www.cisco.com. If no home page is
configured (the default is deleted), the integrated browser tab is blank.
Each browser tab can have its own home page.
To configure a home page:

1. From the Browser Tab drop-down list, select the tab on which you want the
home page to appear.
2. In the Home Page field, type the web address (URL) of the website you want to
appear by default in the integrated browser.
3. Click Update.
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4. Repeat steps 1 through 3 for each tab as desired.
5. Click Apply to save your changes. The home page is set.

Setting Up Work Sites
A work site is a website that is frequently accessed by agents to assist them in their
jobs. They are similar to the “favorites” you can set up in a web browser.
Work sites you set up appear in a drop-down list in the agent’s integrated browser, and
are available no matter which tab is displayed. When the agent selects a work site
from the list, it appears in the integrated browser window. This gives the agent quick
access to the site without having to type its address in the (optional) Address field.
To add a work site:

1. In the Site Name field, type the name of the website you wish to add as a work
site.
2. In the URL field, enter the web address of the website.
3. Click Add. The work site is added to the list in the Work Sites pane.
4. Click Apply to save your changes.
To update a work site:

1. In the Work Sites field, select the work site you wish to update. The
information for the website appears in the Site Name and URL fields.
2. Edit the information as needed, and then click Update. The updated
information appears in the Work Sites pane.
3. Click Apply to save your changes.
To delete a work site:

1. In the Work Sites pane, select the work site you wish to delete. The
information for the website appears in the Site Name and URL fields.
2. Click Delete. The work site is deleted from the Work Sites pane.
3. Click Apply to save your changes.

Remote Access
The Remote Access tab (Figure 34) is used to enable the IPC Receive Event feature
and configure the port used by the feature. This action is available to agents using
Agent Desktop at the Premium level only.
NOTE: The Remote Access feature is not available for CAD-BE.
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An IPC Receive Event occurs when a third party application sends a message to Agent
Desktop over a UDP socket. All attributes that IPC Receive Event actions require in
order to execute are a part of the IPC Receive Event message content. These
messages must adhere to a predefined XML schema (see examples below) and
cannot exceed 4000 bytes. Unlike work flow actions, IPC Receive Event actions do not
require configuration or setup in Desktop Administrator.
When Agent Desktop receives an IPC Receive Event message, it does not send a reply
back. IPC Receive Events are queued so no messages are lost.
By default, IPC Receive Events are disabled. The default port number is Port 58000.
NOTE: The Remote Access action provides for receiving an
asynchronous event. Even if the event is solicited by an IPC Action
request being sent out, the request might never be delivered, and
there is no assurance that a response will arrive because of the
nature of UDP.

Figure 34.

Remote Access tab

Nine actions are supported by the IPC Receive Event:
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IPC Make Call (page 76)l

■

IPC Blind Transfer (page 76)

■

IPC Supervised Transfer (page 77)
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■

IPC Blind Conference (page 77)

■

IPC Supervised Conference (page 78)

■

IPC High Priority Chat (page 79)

■

IPC Record (page 79)

■

IPC Agent Notification (page 79)

■

IPC Set Variable (page 80)

IPC Make Call
For the IPC Make Call action to be successful:
■

The agent must be in the Not Ready state

■

There can be no call appearance present in Agent Desktop

■

The Make Call dialog box must be closed (if it is open, the action will close it)

The message sent to Agent Desktop must conform to this XML format. Bold text
indicates a variable that must be replaced with your own values.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCMakeCallAction>
<ActionName>IPC Make Call Action</ActionName>
<PhoneNumber>2961</PhoneNumber>
<DisplayError>true</DisplayError>
</IPCMakeCallAction>
</IPCActions>

IPC Blind Transfer
The IPC Blind Transfer action transfers the active call directly to the phone number
defined in the IPC message string. The call is transferred to the defined number and
the agent is no longer connected to the call. The Dial Pad is not presented to the
agent.
For the IPC Blind Transfer action to be successful:
■

The agent must be on an active call appearance in Agent Desktop

■

The agent must be in a Talking state. The agent can not have the active call in
a Hold state.

■

If the IPC message string is submitted to Agent Desktop when these
conditions are not met, Agent Desktop will present a generic error message
stating that the agent requested action failed.

The IPC Blind Transfer message sent to Agent Desktop must conform to the following
XML format. Bold text indicates a variable that must be replaced with the telephone
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number to be dialed and the delay value. The delay value is expressed in
milliseconds.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCBlindTransferAction>
<ActionName>IPC Blind Transfer Action</ActionName>
<PhoneNumber>7865551234</PhoneNumber>
<Delay>0</Delay>
<DisplayError>true</DisplayError>
</IPCBlindTransferAction>
</IPCActions>

IPC Supervised Transfer
The IPC Supervised Transfer action initiates a transfer of the active call to the phone
number defined in the IPC message string and presents the Transfer Dial Pad to the
agent for all further call control. The agent can use the Transfer Dial Pad to alternate
between parties, cancel, or complete the call transfer.
For the IPC Supervised Transfer action to be successful:
■

The agent must be on an active call appearance in Agent Desktop

■

The agent must be in a Talking state. The agent can not have the active call in
a Hold state.

■

If the IPC message string is submitted to Agent Desktop when these
conditions are not met, Agent Desktop will present a generic error message
stating that the agent requested action failed.

The IPC Supervised Transfer message sent to Agent Desktop must conform to the
following XML format. Bold text indicates a variable that must be replaced with the
telephone number to be dialed.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCSupervisedTransferAction>
<ActionName>IPC Supervised Transfer Action</ActionName>
<PhoneNumber>7865551234</PhoneNumber>
<DisplayError>true</DisplayError>
</IPCSupervisedTransferAction>
</IPCActions>

IPC Blind Conference
The IPC Blind Conference action conferences the active call directly to the phone
number defined in the IPC message string. The call is conferenced directly with the
defined number and the agent remains connected to the call. The Conference Dial
Pad is not presented to the agent.
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For the IPC Blind Conference action to be successful:
■

The agent must be on an active call appearance in Agent Desktop

■

The agent must be in a Talking state. The agent can not have the active call in
a Hold state.

■

If the IPC message string is submitted to Agent Desktop when these
conditions are not met, Agent Desktop will present a generic error message
stating that the agent requested action failed.

The IPC Blind Conference message sent to Agent Desktop must conform to the
following XML format. Bold text indicates a variable that must be replaced with the
telephone number to be dialed.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCBlindConferenceAction>
<ActionName>IPC Blind Conference Action</ActionName>
<PhoneNumber>7865551234</PhoneNumber>
<DisplayError>true</DisplayError>
</IPCBlindConferenceAction>
</IPCActions>

IPC Supervised Conference
The IPC Supervised Conference action initiates a supervised conference of the active
call to the phone number defined in the IPC message string and presents the
Conference Dial Pad to the agent for all further call control. The agent can use the
Conference Dial Pad to alternate between parties, cancel or complete the conference
transfer.
For the IPC Supervised Conference action to be successful:
■

The agent must be on an active call appearance in Agent Desktop

■

The agent must be in a Talking state. The agent can not have the active call in
a Hold state.

■

If the IPC message string is submitted to Agent Desktop when these
conditions are not met, Agent Desktop will present a generic error message
stating that the agent requested action failed.

The IPC Supervised Conference message sent to Agent Desktop must conform to the
following XML format. Bold text indicates a variable that must be replaced with the
telephone number to be dialed.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCSupervisedConferenceAction>
<ActionName>IPC Supervised Conference Action</ActionName>
<PhoneNumber>7865551234</PhoneNumber>

78

March 1, 2013

User Interface

<DisplayError>true</DisplayError>
</IPCSupervisedConferenceAction>
</IPCActions>

IPC High Priority Chat
For the IPC High Priority Chat action to be successful, the agent must be logged in.
The message sent to Agent Desktop must conform to this XML format. Bold text
indicates a variable that must be replaced with your own values.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCHighPriorityChatAction>
<ActionName>IPC High Priority Chat Action</ActionName>
<MessageText>Need help from supervisor</MessageText>
</IPCHighPriorityChatAction>
</IPCActions>

IPC Record
For the IPC Record action to be successful:
■

A call appearance must be present in Agent Desktop

■

The call must be connected, on hold, or conferenced

■

The call must be the first call appearance listed in Agent Desktop

The message sent to Agent Desktop must conform to this XML format. The action
supports two commands: start and stop.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCRecordAction>
<ActionName>IPC Record Action</ActionName>
<Command>start</Command>
<DisplayError>true</DisplayError>
</IPCRecordAction>
</IPCActions>

IPC Agent Notification
For the IPC Agent Notification action to be successful, the agent must be logged in.
The message sent to Agent Desktop must conform to this XML format. Bold text
indicates a variable that must be replaced with your own values.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCAgentNotificationAction>
<ActionName>IPC Agent Notification Action</ActionName>
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<MessageText>Go to Not Ready state!</MessageText>
</IPCAgentNotificationAction>
</IPCActions>

IPC Set Variable
For the IPC Set Variable action to be successful, the agent must be logged in.
The IPC Set Variable action receives data values (for example, Cisco Outbound Dialer
variables prefixed with “BA”) from a third party application in UDP format. The action
sends these data values to the CTI server.
All variables (ECC variables, call variables, and Outbound Dialer variables) can be set
with this action.
The message sent to Agent Desktop must conform to this XML format. Bold text
indicates a variable that must be replaced with your own values.
<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCSetVariableAction>
<ActionName>IPC Set Variable Action</ActionName>
<Variable>BAResponse</Variable>
<DataValue>03/05/2011 05:45</DataValue>
</IPCSetVariableAction>
</IPCActions>
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Voice Contact Work Flows
Voice contact work flows manage agent activity based on voice call events. Once a call
is classified it is further filtered according to events, rules, and actions. Voice contact
work flows are available to agents who use Agent Desktop and CAD-BE.
Figure 35.

Voice Contact Work Flows flow chart

For example, a voice contact work flow could be set up as follows:
1. A call comes into the contact center and is routed to an agent in the Ready
state.
2. The Voice Contact Classification filter determines which work flow to select. It
examines the inbound call’s enterprise data (original dialed number) and
determines that it is a call for Product A technical support and thus meets the
data conditions of Work Flow 1. The call is now subject to the second layer of
filtering set up in Work Flow 1.
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3. Work Flow 1 says that any ringing event on the Product A support line triggers
an HTTP action. This action takes the customer-entered account information
from the IVR (part of the call’s enterprise data) and pops a web page in the
Agent Desktop or CAD-BE integrated browser that displays the customer’s
account information to the agent.
4. The agent answers the phone call and is ready to assist the customer.

Creating a Voice Contact Work Flow
The general procedure for creating a voice contact work flow is as follows:
1. Set up a new voice contact classification filter:
a. Select the type of call the work flow applies to—inbound, outbound, or all
calls.
NOTE: Depending on which Outbound Dialer dialing mode you are using, a
customer call can appear as inbound or outbound. See "Voice Contact Work
Flows and Outbound Dialer" on page 88 for assistance in choosing the
appropriate call type and event for your work flow.
b. If required, further classify the call by specifying it must meet various data
field conditions.
2. Set up the second level of filtering:
a. Select the call or agent state event—Ringing, Answered, Dropped, Work
Ready, or Work Not Ready.
b. If required, set up one or more rules with data field conditions that the
call must meet.
c. Set up one or more actions that will take place if the call or agent event
meets the rules’ data field conditions.
3. Set up as many second level filters as needed for calls selected by the first
level filter. You can set up rules and actions for each of the filtered call’s call
or agent events.
NOTE: It is possible to set rules and conditions that are contradictory
so that a work flow cannot function. Desktop Administrator does not
check a work flow’s logic and validity. If a work flow fails to operate as
expected, make sure that the rules and conditions you set up are
logically valid.
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Setting Up a New Voice Contact Classification
When you select the Voice Contact Work Flow node in the navigation tree, the Voice
Contact Work Flow List window is displayed. This window shows all the existing voice
contact work flows, and enables you to edit them or to set up new ones.
The Voice Contact Classification is the first level of filtering in a voice contact work
flow.
To set up a new voice contact classification:

1. In the Voice Contact Work Flow List window, click Add. The New Work Flow
Name dialog box is displayed.
2. Enter a name for your new voice contact work flow, and then click OK. The Edit
Voice Contact Classification dialog box appears with the work flow name you
just created (Figure 36).
Figure 36.

Edit Voice Contact Classification dialog box

3. Set up the criteria for the first level filter in this dialog box.
a. Select the type of call you want the filter to apply to from the drop-down
list: inbound calls, outbound calls, or all calls.
Note that there is also the option to disable the work flow. You can select
this option later on if and when you want to disable the work flow, but
want to keep the work flow on file for enabling at a later date.
b. Apply up to three data field conditions. Click Edit to display the Data Field
Condition dialog box. For information on setting up a data field condition,
see "Data Field Conditions" on page 85.
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c. Select if you want the filter to apply when ALL conditions are true, or if
ANY conditions are true.
4. Click OK to complete setting up the first level filter in the new voice contact
work flow.

Setting Up a New Work Flow
After a new voice contact classification is created, Desktop Administrator takes you to
the Voice Contact Work Flow window (Figure 37). In this window you set up the second
level of filtering, consisting of events and rules, and the resulting actions for your new
voice contact work flow.
Figure 37.

Voice Contact Work Flow window

When an event occurs, the rules associated with the event are evaluated in the order
they are listed in the Rules pane. When a rule is met, the actions associated with that
rule are executed in the order they are listed in the Actions pane. Subsequent rules
are not evaluated.
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If no rules are met, the default rule governs, and all actions associated with the
default rule are executed. Default rules cannot be changed or deleted. The default
action might be <no action>.
To set up a new work flow:

1. Select the event that triggers the work flow from the Event pane. The available
events are:
—

Ringing. The agent’s phone rings.

—

Answered. The agent answers the phone.

—

Dropped. The call terminates.

—

Work Ready. The agent transitions to the Work Ready agent state.

—

Work Not Ready. The agent transitions to the Work Not Ready agent state.

2. Under the Rules pane, click New to set up a new rule. The New Rule Name
dialog box appears.
3. Enter the name of the new rule, and then click OK. The fields in the Current
Rule Conditions section of the window are enabled.
4. Add up to 3 data field conditions (see "Data Field Conditions" on page 85 for
more information) and specify when the actions should be executed—when
any one of the data field conditions is met, or when all of the data field
conditions are met. When a data field condition is established, the Enable
Rule check box is automatically selected.
NOTE: You cannot use a route point phone number when configuring a rule for
inbound ACD calls.
5. Under the Actions pane, click Add to choose one or more actions to run when
the event occurs and the rules are met. You can select an existing action, or
create a new action.
NOTE: If the action you select cannot be associated with the event, you will
receive an error message. See "Creating Actions" on page 95 for more
information.
6. Repeat steps 1 through 5 for as many events as desired.
7. When you are finished associating events with rules and actions, click Apply
to save the new voice contact work flow.

Data Field Conditions
Data field conditions are criteria that a call’s selected enterprise data fields must
meet in order for a work flow rule or a voice contact classification filter to be enforced.
You can configure up to 3 data field conditions for a work flow rule and for a voice
contact classification filter. You specify if all the data field conditions must be met (an
AND statement) or if any of the data field conditions must be met (an OR statement).
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To configure data field conditions for a work flow rule, use the Current Rule Conditions
section of the Voice Contact Work Flow window. To configure data field conditions for a
voice contact classification, use the Data Field Condition dialog box (Figure 38).
Figure 38.

Data Field Condition dialog box

To set up data field conditions:

1. In the Voice Contact Classification dialog box, click Edit. In the Voice Contact
Work Flow window, add a new rule and then click Edit in the Current Rule
Conditions section of the window.
2. Select a data field from the Data Field drop-down list.
The Data Field lists all the enterprise data fields used in your system.
Not all data fields are available for all events, for instance, Calling# and
Called# are not available for the Ringing event.
3. Specify one of the data field filters:
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—

Is Empty. The data field is empty.

—

Is Not Empty. The data field is not empty.

—

Is In the List. The data field is compared to the list you set up in the List
pane to determine if it is in that list. Click Add to add an item to the list of
strings. Strings are not case sensitive. You can use wild cards (* and ?) to
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simplify your list. See "Wild Card Searches" on page 87.
—

Is Not in the List. The data field is compared to the list you set up in the
List pane to determine if it is not in that list. Click Add to add an item to
the list of strings. Strings are not case sensitive. You can use wild cards
(* and ?) to simplify your list. See "Wild Card Searches" on page 87.

—

Length of Data. The length of the data field is between a minimum and
maximum number of characters that you set.

4. Ensure that the Enable Condition check box is selected, then click OK.

Wild Card Searches
You can use wild cards when entering strings in the data field conditions list pane.
This enables you to avoid having to enter many strings if the strings you want to list
have common elements.
Wild card characters used are the asterisk (*) and the question mark (?).
An asterisk in a string replaces any quantity of characters, as long as the other
characters in the string match. For instance, ABC* matches strings that begin with
ABC but end in any quantity of any characters.
A question mark in a string replaces any character, but the length of the string must
be exactly as represented. For instance, ABC?? matches strings that begin with ABC
and end in two other characters.
Double quotes around a string searches for the exact characters within the double
quotes, including the wild card characters (*) and (?). For instance, “123*ABC”
matches only the string 123*ABC, and does not allow the asterisk to act as a wild
card.

Modifying a Voice Contact Work Flow
You can modify the default work flow and any custom work flows you create.
NOTE: The classification filter for the Default work flow is Inbound
Calls. This cannot be changed.
To modify a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to
modify, and then click Edit.
■
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■

If you select the default work flow, the Voice Contact Work Flow window
appears. The default work flow does not classify voice contacts, and so
bypasses the Edit Voice contact Classification dialog box.

2. Modify the voice contact classification if desired, and then click OK to proceed
to the Voice Contact Work Flow window.
3. Modify the work flow as desired, and then click Apply to save your changes.

Voice Contact Work Flows and Outbound Dialer
Cisco Unified Outbound Dialer has four dialing modes. These dialing modes include
events that do not always map to work flow events. Table 12 displays how the
Outbound Dialer events map to voice work flow events to assist you in creating work
flows for Outbound Dialer campaigns.
Table 12.

Outbound Dialer events and CAD Work Flow events

Dialing Mode

Voice Contact

Outbound 
Dialer Event

Work Flow Event

Direct Preview

Outbound

Reserved/Offered

None

Accept

None

Connected

Answered

Dropped

Dropped

Reserved/Offered

Ringing & Answered

Accept

Dropped

Connected

Answered

Dropped

Dropped

Reserved/Offered

Ringing & Answered

Accept

Dropped

Connected

None

Dropped

None

Reserved/Offered

None

Accept

None

Connected

None

Dropped

None

Inbound & Outbound

Inbound

Preview

88

Outbound

March 1, 2013

Voice Contact Work Flows

Table 12.

Outbound Dialer events and CAD Work Flow events (cont’d)

Dialing Mode

Voice Contact

Outbound 
Dialer Event

Work Flow Event

Preview
(cont’d)

Inbound & Outbound

Reserved/Offered

Ringing & Answered

Accept

None

Connected

Dropped & Answered

Dropped

Dropped

Reserved/Offered

Ringing & Answered

Accept

None

Connected

Dropped & Answered

Dropped

Dropped

Ringing
(customer’s
phone)

None

Inbound

Predictive

Outbound

Connected

None
None

Dropped
Inbound/Outbound

Inbound

Progressive
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Outbound

Ringing
(customer’s
phone)

Ringing & Answered

Connected

Dropped & Answered

Dropped

Dropped

Ringing
(customer’s
phone)

Ringing & Answered

Connected

Dropped & Answered

Dropped

Dropped

Ringing
(customer’s
phone)

None

Connected

None

Dropped

None
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Table 12.

Outbound Dialer events and CAD Work Flow events (cont’d)

Dialing Mode

Voice Contact

Progressive
(cont’d)

Inbound/Outbound

Inbound

Outbound 
Dialer Event

Work Flow Event

Ringing
(customer’s
phone)

Ringing & Answered

Connected

Dropped & Answered

Dropped

Dropped

Ringing
(customer’s
phone)

Ringing & Answered

Connected

Dropped & Answered

Dropped

Dropped

Deleting a Voice Contact Work Flow
You can delete any custom work flow you create. You cannot delete the default work
flow.
To delete a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to
delete, and then click Delete. A popup window appears asking you to confirm
you want to delete the work flow.
2. Click OK to confirm the deletion.
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Agent Management Work Flows
Agent management work flows manage agent activity based on Agent Desktop and
CAD-BE activity, agent ACD states, and time of day. The work flows follow the event—
rule—action behavior used by voice contact work flows. One important difference is
that there is no initial filtering similar to the voice contact classification applied to
voice contacts.
Figure 39.

Agent Management Work Flows flow chart

For example, agent management work flows could be set up as follows:
■

Every work day at 4:30, agents receive a popup message reminding them to
complete their time cards.

■

Whenever Agent Desktop starts up, Notepad is launched on the agent’s
desktop.

■

Whenever an agent logs in, the customer database is launched.

Creating an Agent Management Work Flow
The general procedure for creating an agent management work flow is as follows:
1. Select the event that triggers the work flow.
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2. If the event is time of day, set up a rule with one or more data conditions that
the event must meet.
NOTE: It is possible to set rules and conditions that are contradictory so that a
work flow cannot function. Desktop Administrator does not check a work
flow’s logic and validity. If a work flow fails to operate as expected, make sure
that the rules and conditions you set up are logically valid.
3. Set up one or more actions that will take place whenever the event occurs, or,
if a time of day event, whenever the rule is met.
When you select the Agent Management Work Flow node, the Work Flow window
appears (Figure 40).
Figure 40.

Work Flow window

Unlike rules in voice contact work flows, rules in agent management work flows can be
applied only to a time of day event, not to all events.
Not all actions are available for agent management work flows. See "Action
Availability" on page 96 for more information.
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To set up a CAD Agent activity or agent state work flow:

1. Select the event that triggers the work flow from the Event pane. The available
events are:
—

Startup. Agent Desktop/CAD-BE starts.

—

Shutdown. Agent Desktop/CAD-BE closes.

—

Logged in. The agent logs into Agent Desktop/CAD-BE.

—

Logged out. The agent logs out of Agent Desktop/CAD-BE.

—

Ready. The agent transitions to the Ready state.

—

Not Ready. The agent transitions to the Not Ready state.

2. Under the Actions pane, click Add to choose one or more actions to run when
the selected event occurs. You can select an existing action, or create a new
action. See "Creating Actions" on page 95 for more information.
3. Repeat steps 1 and 2 for as many events as desired.
4. When you are finished associating events with actions, click Apply to save the
agent management work flow.
To set up a time of day work flow:

1. Select the Time of day event from the Event pane.
2. Under the Rules pane, click New to set up a new rule. The New Rule Name
dialog box appears.
3. Enter the name of the new rule, then click OK. The fields in the Current Rule
Conditions section of the window are enabled, and the Time of Day Condition
dialog box appears (Figure 41).
Figure 41.
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4. Set up the day or date conditions for the rule, then click OK. The condition you
set up is automatically entered in the first Data Field Conditions line in the
Current Rule Conditions section of the Work Flow window, and the Enable
Rule check box is automatically selected.
a. To specify that an action takes place every week on certain days or at a
certain time, select Day(s) of the week and then check the desired days.
You must specify a time of day as well.
b. To specify that an action takes place on a specific date, select Date, and
then select the desired date from the calendar. Today’s date is circled in
red. You must specify a time of day as well.
5. Click Edit next to the 2 remaining Data Field Conditions fields to further define
the rule, if desired:
■

Specify if the agent is on hook or off hook

■

Specify if the agent state is or is not equal to Ready or Not Ready

Figure 42.

State Condition dialog box

6. Under the Actions pane, click Add to choose one or more actions to run when
the event occurs and the rules are met.
You can select an existing action, or create a new action. See "Creating
Actions" on page 95 for more information.
7. Click Apply to save the new time of day work flow.

94

March 1, 2013

Creating Actions

Creating Actions
Actions are stored independently of events and rules. You can use an action in more
than one event, and you can assign actions to more than one task button in Agent
Desktop and CAD-BE.
While actions are processed, events are queued. It is generally a good idea to avoid
long actions. Table 13 summarizes the availability of each action for agents who use
Agent Desktop and agents who use CAD-BE. The symbol “×” indicates the action is
available, and the symbol “—” indicates the action is not available.
Table 13.

Actions and their availability to agents who use Agent Desktop and CAD-BE

Agent
Desktop

CAD-BE

Importing and Exporting Actions (page 98). Displays a popup
message on the agent’s desktop.

×

—

Creating Agent State Actions (page 103). Sets an agent state.

×

—

Creating Call Control Actions (page 105). Answers, drops,
conferences, transfers, or makes a call, or inputs touch tones
during a call.

×

—

Creating Delay Actions (page 106). Adds delay time between
actions in a series of actions.

×

—

Creating HTTP Actions (page 106). Enables the Agent
Desktop integrated browser to interact with a web
application.

×

×

Creating Agent Notification Actions (page 102). Displays a
custom message on the agent’s desktop when a certain
event occurs

×

—

Creating IPC Actions (page 113). Passes enterprise data or
user-defined data from the agent desktop to a custom
third-party application.

×

—

Creating Launch External Application Actions (page 115).
Starts a third-party application.

×

—

Creating Run Macro Actions (page 116). Plays back a
recorded sequence of keystrokes.

×

—

Creating Set Enterprise Data Actions (page 125).
Automatically changes an enterprise data field in Agent
Desktop to a selected desktop variable or static text.

×

—

Action Type and Description
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Table 13.

Actions and their availability to agents who use Agent Desktop and CAD-BE (cont’d)

Agent
Desktop

CAD-BE

Creating Timer Actions (page 127). Triggers actions after a
specified time has elapsed.

×

—

Utility Action (page 128). Run a utility, such as start and stop
recording or sending a predefined, high-priority chat message
to a supervisor.

×

×

Action Type and Description

Action Availability
Not all actions are available for all events or for all types of agents. Table 14 shows
which actions are available for the three types of work flows and for each type of agent
(Agent Desktop agents and CAD-BE agents). The symbol “×” indicates the action is
available, and the symbol “—” indicates the action is not available.
Table 14.

Action availability per work flow type and agent type

Voice Contact

Time of Day

Agent
Desktop

CAD-BE

Agent
Desktop

CAD-BE

Agent
Desktop

CAD-BE

Agent Notification

×

—

×

—

×

—

Agent State

×

—

—

—

×

—

Call Control

×

—

—

—

—

—

Delay

×

—

×

—

—

—

HTTP

×

×

×

—

×

—

IPC

×

—

×

—

—

—

Launch External
Application

×

—

×

—

—

—

Run Macro

×

—

×

—

—

—

Set Enterprise
Data

×

—

—

—

—

—

Timer

×

—

—

—

—

—

Utility

×

×

—

—

—

—

Action Type
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Adding a New Action
To add a new action:

1. Access the Voice Contact Work Flow or Agent Management Work Flow
window.
2. Select the event to be associated with the new action.
3. Under the Actions pane, click Add. The Select Action dialog box appears
(Figure 43).
Figure 43.

Select Action dialog box

4. Choose the tab for the type of action you want to associate with the event.
5. If the action already exists, select it, then click OK. If the action does not yet
exist, click New, then follow the instructions for setting up that type of action
as outlined below.
6. Click OK. The Select Action dialog box closes and you return to the Work Flow
window. The new action is listed in the Actions pane.
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Editing an Action
To edit an action:

1. In the Work Flow window, select the appropriate event, and then select the
action you want to edit from the Actions pane.
2. Click Edit. The edit dialog box for that action appears.
3. Make your changes, and then click OK. The action is now changed.

Deleting an Action
To permanently delete an action, you must first delete it from any event it is
associated with, and then delete the action itself.
To permanently delete an action:

1. In the Work Flow window, select an event.
2. If the action you want to delete is associated with the event, select the action
in the Action pane, then click Delete to remove the action from the event.
3. Repeat steps 1 and 2 for all of the other events. The action is now removed
from all events.
4. Under the Actions pane, click Add. The Select Actions window appears.
5. Choose the appropriate tab, and then select the action you want to delete.
6. Click Delete. The action is deleted.
7. Click Cancel. The Select Action window closes, returning you to the Work Flow
window.

Importing and Exporting Actions
You can export actions associated with a specific work flow group and import them to
other work flow groups. The actions are exported to any location you choose, locally or
on a network drive.
NOTE: If you export actions to the default location on your PC, which
is C:\Program Files\Cisco\Desktop\config\Action, the actions will be
lost if a client desktop is reinstalled. To avoid this issue, export
actions to a folder that is not in the CAD installation directory (which is
C:\Program Files\Cisco\Desktop).
The actions you export can be imported by other instances of Desktop Administrator,
belonging to your system or any other system, as long as those instances are the
same version of Desktop Administrator and can access the file storage folder.
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Types of actions that can be exported and imported are:
■

Run Macro action

■

HTTP action

■

IPC action

■

Launch External Application action

The rules and events associated with the actions are not part of this function and
cannot be exported or imported.
You can export only one action at a time. For example, if there are five actions you
want to export from a work flow group, you must export each action individually.
You can add a description (limited to 255 characters) to the exported action for easier
identification when importing to another work flow group.
If an imported action has the same name as an action already present in the work
flow group, you will be prompted to rename the imported action.
To export a work flow action:

1. Select the work flow group whose action you want to export. The Import Export
Work Flow Actions window appears (Figure 44). The Import and/or Export
buttons are enabled only if there are actions available for import/export.
Figure 44.
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2. Click Export. The Export Action dialog box appears (Figure 45).
Figure 45.

Export Action dialog box

3. Select the action you want to export from the Action List, then complete the
fields in the dialog box.
■

Folder Path. Select the default path shown or browse to any other local or
network folder location.

■

Description (optional). Enter a description of the action. Maximum length
of the description is 255 characters.

4. Click OK.
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To import a work flow action:

1. Select the work flow group to which you want to import an action. The Import
Export Work Flow Actions window appears (Figure 44).
2. Click Import. The Import Select dialog box appears (Figure 46).
Figure 46.

Import Select dialog box

3. Navigate to the folder where actions are stored. The field is autofilled with the
default path.
4. From the Action Names list, select the action you want to import to the work
flow group. You can import only one action at a time.
5. Click OK.
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Creating Agent Notification Actions
An Agent Notification action displays a custom message popup window on the agent’s
desktop when a certain event occurs. For instance, when an agent logs out, a popup
window reminding the agent to complete his time card could pop up on his desktop.
To set up an Agent Notification action:

1. Set up a new action. (For instructions, see "Adding a New Action" on page 97.)
The Select Action window appears.
2. Select the Agent Notification tab, and then click New. The Agent Notification
Action Setup dialog box appears (Figure 47).
Figure 47.

Agent Notification Action Setup dialog box

3. Type an action name, select an icon for the popup window, type a message,
then click Preview (Figure 48). A preview of your popup window appears.
NOTE: The title bar on the actual popup window might contain truncated text,
because Windows automatically adds “Cisco Agent Desktop” to the beginning
of the title bar text and the popup window does not resize.
Figure 48.

Preview of an Agent Notification popup window

4. Click OK.
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Creating Agent State Actions
An Agent State action enables you to select an agent state to associate with an event.
Agent State actions can be associated only with Answered and Dropped events. The
only valid agent states are Ready, Not Ready, Work Ready, and Work Not Ready.

NOTE: You can associate agent states with the Dropped event, but
any agent state transitions configured in Unified ICM will probably
take precedence over the agent state action you configure here.
To set up an Agent State action:

1. Set up a new action. See "Adding a New Action" on page 97. The Select Action
window appears.
2. Select the Agent State tab, then click New. The Agent State Action Setup box
appears (Figure 49).
Figure 49.

Agent State Action Setup dialog box

3. Enter a name for the action, select the agent state control from the drop-down
list, then click OK.

Automated Reason Codes for Agent State Changes
You can enable automated reason codes when you set up an agent state action for
transitioning to Logout or Not Ready.
If you enable automated reason codes, the agent does not have to choose the
appropriate reason code when an agent state action to transition to Logout or Not
Ready is triggered.
To enable automated reason codes

1. Set up a new Agent State action ("Creating Agent State Actions" on page 103)
or edit an existing Agent State action ("Editing an Action" on page 98).
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2. In the Agent State Action Setup dialog box, type a name for the action and
select AgentNotReady or AgentLogout from the Agent State Control drop-down
list. The Automate Reason button appears in the dialog box (Figure 50).
Figure 50.

Agent State Action dialog box with Automate Reason button

3. Click Automate Reason. The Select Reason dialog box appears (Figure 51).
Figure 51.

Select Reason dialog box

4. Select a reason code to be entered automatically when the action is triggered,
then click OK. The Select Reason window closes and the Agent State Action
Setup window displays the number of the selected reason code next to the
Automate Reason button.
NOTE: Selecting “Agent will choose” forces the agent to enter a reason code.
5. Click OK.
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Creating Call Control Actions
You can associate an event or a task button with a call control action, such as blind
transferring a call to an agent’s supervisor. Call control actions include:
■

Blind conference

■

Blind transfer (includes a configurable delay time)

■

Supervised conference

■

Supervised transfer

■

Call

■

Drop

■

Touch tones

■

Answer
NOTE: A work flow to answer calls on a Ringing event cannot be used
by mobile agents in Call-by-Call mode, as they answer calls manually.

The blind conference action requires one or more rules that define when the action
should be executed (for example, incoming calls from a route point). If the action does
not have any rules, it will be executed every time the event with which it is associated
occurs. For example, if you create a blind conference action on an answered event
without any rules, the action will be executed for every answered call.
To set up a Call Control action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the Call Control tab, then click New. The Call Control Action Setup
window appears (Figure 52).
Figure 52.
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3. Type a name for the call control action, select an action from the Call Control
drop-down list, then type a phone number, if required. For example, for a Blind
Transfer, type a phone number to which the call is transferred.
4. Click OK.

Creating Delay Actions
Delay actions are used to add delay time between actions in a series of actions. For
example, you can add a delay action between two macros in a work flow.
To set up a Delay action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the Delay Action tab, then click New. The Delay Action Setup window
appears (Figure 53).
Figure 53.

Delay Action Setup window

3. Type a name for the delay action and the length of delay time in milliseconds.
If you want events to be processed in the background during the delay, select
the Process Events During Delay check box. Click OK.

Creating HTTP Actions
HTTP actions enable an agent to use call-based data to interact with a website or a
web application in the Integrated Browser window. For example, an HTTP action can
be set up so the enterprise data of an incoming call is used to retrieve a customer
record and display it in the Integrated Browser.
NOTE: For more information about HTTP requests and the HTTP
protocol, see the World Wide Web Consortium website, www.w3.org.
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The Post and Get HTTP actions are available to agents who use Agent Desktop at the
Premium level. The Get HTTP action is available to agents who use CAD-BE at the
Enhanced and Premium levels.
NOTE: A URL with arguments is limited by the HTTP service to a
maximum of 2075 characters. If you create an HTTP action that
results in a longer URL, the action will not work correctly.
To set up an HTTP action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the HTTP Action tab, then click New. The HTTP Actions Setup window
appears (Figure 54).
Figure 54.
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3. Complete the HTTP Actions Setup dialog box as follows:
Field

Description

Action Name

The new action name.

Protocol

The protocol to be used: http (default) or https.

Method

The http method to be used: GET (default, Agent Desktop
and CAD-BE) or POST (available in Agent Desktop only).

Host

The website host name or IP address. Omit the protocol.

Port

The port (0–65535) that the host is listening on. The
default for http is 80. The default is 443 for https.

Path

Optional. The path portion of the URL. Default is blank. Do
not include a leading slash.

Browser Tab

The browser tab in which you want the action results to be
displayed. If the tab you select is removed later, the action
will be displayed in the first tab (ordinarily reserved for
supervisor page push). This field is not present In CAD-BE,
since CAD-BE only has 1 tab.

4. Click Add to display the HTTP Request Data dialog box (Figure 55).
The fields added with this dialog box make up the query or post data portion
of the request. The fields are optional and are blank by default.
Figure 55.
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5. Complete the HTTP Request Data dialog box as follows:
Field

Description

Value Name

Enter the name of the field in the web application.

Value Type

One of the following:
• DataField: An enterprise data variable is the source of
the data. Uses the format <name>=<value>.
• UserDefined: A specific string entered in the Value field.
Uses the format <name>=<value>.
• DataFieldOnly: Any value from the Value drop-down list.
Does not use the format <name>=<value>.

Value

If Value Type is UserDefined, the actual value. If Value Type
is DataField or DataFieldOnly, the enterprise data variable.

Test Data

A string to simulate DataField or DataFieldOnly data.
Enabled only if Value Type is DataField or DataFieldOnly.

6. Continue to build your request using the Add, Edit, and Delete buttons.
7. When you have completed building the request, click Preview to view the
request. Note that Desktop Administrator has added the special characters
needed for a valid HTTP request. Supported formats are as follows:
■

If a path is specified and there is request data, there will be a “/” after the
port and a “?” after the path.
Example: http://www.site.com:80/index.jsp?name=value

■

If a path is not specified, there is request data, and the first request data
is not DataFieldOnly, there will be a “?” after the port and no “/”.
Example: http://site.com:80?name=value

■

If a path is not specified, there is request data, and the first request data
is DataFieldOnly, there will be a “/” after the port and no “?”.
Example: http://www.site.com:80/value

■

If a path is not specified, there are several request data, and the first
request data is DataFieldOnly, there will be a “/” after the port and no “?”.
Example: http://www.site.com:80/value&value&value…

8. When you are satisfied your request is correctly formatted, click Test to test it
using the test data you entered when adding the request data.
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Reserved Characters
Table 15 lists the reserved characters. Reserved characters must not be used in an
HTTP request.
Table 15.

Symbol

110

Reserved characters

Name

Symbol

Name

Symbol

Name

&

Ampersand

“

Double quote

#

Pound sign

@

At sign

=

Equal sign

?

Question mark

\

Back slash

!

Exclamation
point

>

Right angle
bracket

^

Carat

<

Left angle
bracket

]

Right square
bracket

:

Colon

[

Left square
bracket

;

Semi-colon

,

Comma

%

Percent

‘

Single quote

$

Dollar sign

+

Plus

/

Slash
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Example of an HTTP Request
The following procedure shows how to create an HTTP request using Google search
engine to search for “Cisco Systems.”
To learn what value names and values go into the Google search:

1. Open your web browser and navigate to www.google.com.
2. Type Cisco Systems in the search field, then click Google Search. The address
bar shows the HTTP request that we will create (Figure 56).
Figure 56.

Google Search results page

3. The Address bar displays the following string, containing the host and path,
then a question mark, then the request data, separated by ampersands (&).
The request data and values are user defined. The value name is on the left
side of the equal sign, and the value is on the right side of the equal sign.
www.google.com/search?ie=UTF-8&oe=UTF-8&sourceid=gd&q=Cisco+
Systems&wxob=0
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Name

Value

Host

www.google.com

Path

search

Browser Tab

HTTP Web Browser Tab 1

Request Data

ie=UTF-8
oe=UTF-8
sourceid=gd
q=Cisco+Systems
wxob=0
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To create the HTTP request:

1. Complete the HTTP Actions Setup dialog box with the information you
gathered from the manual Google search (Figure 56).
NOTE: Google inserted a plus sign (+) between the words “Cisco” and
“Systems” in the request string. When you enter the request data, you can
omit that character. Desktop Administrator will automatically add the
characters that indicate a space.
2. After you enter the request data, click Preview to view the resulting string. It
should be identical to the string displayed in the Google search results
address bar. If you typed a plus sign between the words Cisco and Systems,
the string will contain “%2B” instead of a plus sign. If you typed a space, the
string will contain “%20”. Both strings indicate a space and are acceptable
substitutes for the plus sign.
3. Click Test to test your HTTP request. The request should open your browser,
navigate to the Google Search page, and run a search for “Cisco Systems”.
Figure 57.
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Creating IPC Actions
This action is available to agents using Agent Desktop at the Premium level.
IPC actions pass information in the form of UDP (user datagram protocol) messages
from Agent Desktop to a third-party application using IPC (interprocess
communication) methods. The third-party application can be located on the agent’s
PC or anywhere on the network.
NOTE: The third-party application must be coded specifically to listen
for data sent to a specific IP address and port.
An IPC action is one-way—that is, when Agent Desktop sends data using an IPC action,
it does not receive a response or any acknowledgement that the message was
received by the recipient third-party application.
The data sent is enterprise data or user-defined data. It is sent in the format:
valuename=value&name=value&name=value…

To set up an IPC action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the IPC Action tab, then click New. The IPC Action Setup window
appears (Figure 58).
Figure 58.
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3. Complete the fields in the IPC Action Setup window as follows:
Field

Description

Action Name

The name for the new action.

Protocol

The default (and only) protocol is UDP.

IP Address

The IP address of the third-party application that listens.

Port

The port on which the third-party application listens.

4. Click Add to display the IPC Request Data dialog box (Figure 59). The fields
added with this dialog box make up the query portion of the request.
Figure 59.

IPC Request Data dialog box

5. Complete the IPC Request Data dialog box as follows:
Field

Description

Value Name

The name of the field.

Value Type

The source of the data. DataField indicates an enterprise
data variable. UserDefined indicates a specific string
entered in the Value field.

Value

If the Value Type is DataField, the enterprise data variable.
If the Value Type is UserDefined, the value to be used.

6. Continue to build your request using Add, Edit, and Delete as needed.
7. When you have completed building the request, click OK.
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Creating Launch External Application Actions
Launch External Application actions start a third-party application in a new window.
To ensure applications are running before macros attempt to use them, start them
with launch actions assigned to the Startup event.
NOTE: An application started by a launch action must use the same
path on the agent’s PC as it does on the administrator’s PC or it must
be on a network drive, or the launch action will not be successful.
When using launch actions, Agent Desktop can pass parameters such as command
line arguments in two ways.
The first method is to add parameters after the application path name. For example,
the command to start Microsoft Excel and open a spreadsheet named mrmtest.xls is:
“c:\program files\excel.exe” “c:\my documents\mrmtest.xls”
NOTE: Program names and command line arguments that contain
spaces must be in quotes so that they appear as one argument rather
than as multiple arguments.
The second method involves passing data fields as arguments. You can pass any valid
data field while launching an application.
NOTE: If a launch action takes place on the Startup event, call data
might not be present. Empty data fields will contain the string
<NULL>.
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To set up a Launch External Application action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the Launch External Application Action tab, then click New. The
Launching External Application Action Setup window appears (Figure 60).
Figure 60.

Launching External Application Action Setup window

3. Type an action name and the path to the location of the desired application.
Ensure that the application is in a location that is available to Agent Desktop
at runtime.
4. Add any arguments you wish to pass to the application. Choose the desired
argument in the Available Arguments list, and use the left arrow to add it to
the Argument list. Use the up and down arrows to reorder the Argument list.
5. When you have finished entering information, click OK.

Creating Run Macro Actions
A macro is a shortcut for a sequence of keystrokes. For example, you might record a
macro that performs the following tasks with each incoming call:
1. Copy the ANI (Automatic Number Identification) from Agent Desktop to
Microsoft Outlook.
2. Open a contact list.
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3. Find the ANI in a database or spreadsheet.
4. Display a screen containing the caller’s account information.
NOTE: Do not use a Run Macro action for tasks that can be done with
another action type. For example, use a Call Control action to transfer
a call, and an Agent State action to change agent states.
NOTE: Run Macro actions do not work correctly when using Chinese
and Korean characters (and potentially any multi-byte characters).

Macro Recording Tips
If your macro accesses a third-party application, make sure that the application is
open. If the macro enters text into the third-party application, make sure that
application has Windows focus.
Keystroke macros play back to the top level window they were recorded in. If you are
running a keystroke macro to a Terminal Services window, you must make sure that
the appropriate application in that Terminal Services window always has focus,
otherwise the keystrokes will be sent to the wrong application.
Before you begin to record the macro, make a test run with the third-party application,
writing down all of the keystrokes required for the tasks you wish to perform.
Use keyboard shortcut keys to perform actions in the application. Avoid using the
following actions in a macro.
■

Tab or arrow keys, because the cursor might not be in the same place every
time a window opens

■

Mouse clicks and movements, because they are not recorded
NOTE: The execution of a macro can be affected by the client PC
keyboard settings. Ensure that keyboard settings, such as Caps Lock,
are not inadvertently left on. Warn agents not to enter keystrokes
while a macro is running, since that can affect the macro.

Shortcut keys are indicated by an underlined letter in the button name, field name, or
description. To perform the action, press Alt, Ctrl, or Shift plus the underlined letter.
Pressing Alt+E clicks the Edit button (Figure 61).
Figure 61.
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The exact keystrokes for a keyboard shortcut are listed in the application’s menu. For
instance, in Microsoft Word, to find out what the shortcut is to save a document,
choose File from the menu bar. On the drop-down menu the Save option is followed by
its shortcut, Ctrl+S.
Table 16 lists common Windows shortcuts.
Table 16.

Windows shortcuts

Shortcut

Description

Esc

Cancels an action.

Enter

Clicks OK or the default button in a dialog box. (Default buttons are
surrounded by a heavier border.)

Ctrl+A

Selects all text.

Ctrl+C

Copies selected text to the clipboard.

Ctrl+P

Prints the document.

Ctrl+S

Saves the document.

Ctrl+V

Pastes text into the window at the cursor position.

Ctrl+X

Cuts selected text to the clipboard.

A macro can include keystrokes for multiple applications. For example, one macro can
include keystrokes for word processing, spreadsheet, and database applications. To
switch between applications when recording a macro, use the mouse to select the
application. Do not press Alt+Tab. If you do, these keystrokes are recorded and might
not select the correct application when you play back the macro.
NOTE: Do not press Ctrl+Esc to click the Microsoft Windows Start
button, or the Macro Recorder stops recording without providing a
message showing that recording has stopped. All keystrokes recorded
up to this point are deleted. To click Start without causing an error or
stopping recording, use your mouse.
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Allowed Macro Keystrokes
Table 17 lists the keystrokes that are allowed in macros.
Table 17.

Allowed Macro Keystrokes—Keys

Key Type

Key

Character

0123456789

Macro Notation

ABCDEFGHIJKLMNOPQRSTUVWXYZ
*+;=,-./`[ \ ]'
Non-Character

March 1, 2013

Tab

[TAB]

Backspace

[BACKSPACE]

Enter/Return

[ENTER]

Shift

[SHIFT]

Control/Ctrl

[CONTROL]

Alt

[ALT]

Pause/Break

[PAUSE]

Caps Lock

[CAPSLOCK]

Esc

[ESC]

Space/Space Bar

[SPACE]

Page Up/PgUp

[PAGE-UP]

Page Down/PgDn

[PAGE-DOWN]

End

[END]

Home

[HOME]

Left Arrow

[LEFT-ARROW]

Up Arrow

[UP-ARROW]

Right Arrow

[RIGHT-ARROW]

Down Arrow

[DOWN-ARROW]

Print Scrn

[PRINTSCREEN]

Insert

[INSERT]

Delete

[DELETE]

F1 through F24

[F1] … [F24]

119

Cisco Desktop Administrator User Guide

Table 18 lists the special commands that are allowed in macros.
Table 18.

Allowed Macro Special Commands

Special Command

Description

[ENTERPRISE FIELD:]

Inserts an Enterprise Data field.

[DATA FIELD:]

Inserts data from Agent Desktop.

[SYSTEM FIELD:]

Inserts data from Agent Desktop system fields.

[APPLICATION:=]

Changes focus to an application window. The equals sign
(=) separates the application name and window title. If
either the application name or window title is missing,
Agent Desktop attempts to find the correct application and
window to play the macro to, based on the parameters.

[DELAY]

Time, in milliseconds, to wait before performing the next
macro command. For example: [DELAY] 1000 delays the
next macro key or command by 1 second.

Recording Macros
To record a macro:

1. Start and minimize any third-party applications you want in the macro.
2. Set up a new action. For instructions, see "Adding a New Action" on page 97.
The Select Action window appears.
3. Select the Run Macro tab, then click New. The New Macro dialog box appears.
4. Enter a name, then click OK. The Macro Editor window appears. Figure 62
shows the Macro Editor window with a macro named “Ringing Macro.”
Figure 62.
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5. Click Record. The Macro Editor window minimizes and the macro recorder
starts. Anything you type from now on is entered in the new macro.
6. Maximize the third-party application and begin typing.
7. If you want to insert a data field, press the Pause Macro hot key (the default
is F2). The Macro Recorder Suspended dialog box appears (Figure 63).
NOTE: Do not change the focus from the third-party application to the macro
recorder before pressing the Pause Macro hot key. If you do, an error message
will appear, interrupting your macro recording.
Figure 63.

Macro Recorder Suspended dialog box

8. Click Insert Data. The Select a Data Field dialog box appears (Figure 64). For
more information, see "Data Fields" on page 122.
Figure 64.
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9. Choose the desired data field from the list, enter test data if desired, then
click OK. The test data you enter is displayed in the application only when the
macro is tested using the Playback function. The Macro Recording Suspended
dialog box appears.
10. Click Resume Recording to continue recording the macro.
11. Once you have finished recording the macro, press the macro hot key. The
Macro Recording Suspended dialog box appears.
12. Click End Recording. You are returned to the Macro Editor window.
13. You can take any of the following actions:
■

■

To save the macro as recorded, click OK.
—

If the macro has no errors, the macro is saved and you are returned to
the Select Action dialog box.

—

If the macro has errors, the macro editor displays the line and
highlights the text in question. Correct it and click OK again.

To test the macro, click Playback.
—

If the macro has errors, the macro editor displays the line and
highlights the text in question. Correct it and click Playback again.

—

If the macro has no errors, the macro is played back. If it works as you
intend, click OK to save it and return to the Select Action dialog box.

■

To change test data, choose Data > Change Test Data in the macro editor
and enter new test data.

■

To cancel the macro, click Cancel. The macro is canceled and the Select
Action dialog box appears.

Data Fields
The Select a Data Field dialog box (Figure 64) enables you to select and insert a Agent
Desktop data field into a macro. Access this dialog box either through the Suspend
Macro Recording dialog box or from the Data menu in the Macro Editor window.
There are three types of data fields, which can be included in the Run Macro and
Launch External Application work flow actions.
■

Standard. Data from the switch.

■

System. For example, the date and time. Enclosed in square brackets [ ].

■

Enterprise. From the Enterprise service. Marked with an asterisk (*).
NOTE: Not every data field is available for every event. For example,
the calling number is not available during a startup event. If a macro
uses an unavailable field to pop an application, the application
displays <N/A>.
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Table 19 lists the available data fields.
Table 19.

Enterprise Data Fields

Data Field

Description

*Account Number

Customer’s account number.

*Alerting Number

Number of ringing device.

*ANI

Number of the phone that made a call.

*Application Data

ISDN user-to-user information element.

*BAAccountNumber

Outbound Dialer: Customer’s account number.

*BABuddyName

Outbound Dialer: Customer's first and last name,
separated by a comma.

*BACampaign

Outbound Dialer: Name of campaign to which the call
belongs.

*BADialedListID

Outbound Dialer: Unique key identifying a specific
customer record in the Dialing_List table in the BA
private database.

*BAResponse

Outbound Dialer: Multi-purpose variable that sends
data from Agent Desktop to the BA Dialer. Variable
responds to the reservation call, schedule and cancel
callbacks, and changes to the callback number.

*BAStatus

Outbound Dialer: Two characters indicating mode and
direction of the BA Dialer-initiated call. The first
character identifies the call mode:
• R: Reservation call, Predictive or Progressive
mode
• P: Reservation call, Preview mode
• C: Customer call
• A: Reservation call, personal callback
During a reservation call, the first character is P, R, or
A. When a customer call is transferred to an agent,
the first character is C.
The second character of BAStatus indicates call
direction:
• O: Outbound
• I: Inbound
• B: Blended
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Table 19.

Enterprise Data Fields (cont’d)

Data Field

Description

*BATimeZone

Outbound Dialer: Indicates the GMT offset, in
minutes, for the customer’s time zone and obtains
the customer’s local time. The format is either a
positive or negative sign, followed by 5 digits
(+/-#####). For example:
• If customer is one hour behind GMT:
BATimeZone = -00060
• If customer is two hours ahead of GMT:
BATimeZone = +00120
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*Call Duration

Difference between the call’s end time and start time.
The time is read from the Enterprise server clock.

*cisco.com.Category

Reserved for future use.

*cisco.com.MessageKey

Reserved for future use.

*cisco.com.Priority

Reserved for future use.

*Collected Digits

Digits entered by the caller in response to IVR
prompting.

*DNIS

Number of the phone that received a call.

*ICM Call Variable 1…
*ICM Call Variable 10

Call-related variable data. Ten variables are available.

*Last Called Number

Last number dialed.

*Last Calling Number

Last device that made a call.

*Last Connected Number

Last monitored device that joined the call.

*Last Redirection Number

Last number from which the call was redirected.

*Layout

Name of the enterprise data layout.

*Trunk ID

Device ID of the trunk.

*UCID

Not applicable.

[AGENT_ID]

Agent’s identification.

[CALL_DURATION]

Difference between the call’s end time and start time.
The time is read from the agent’s PC’s clock.
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Table 19.

Enterprise Data Fields (cont’d)

Data Field

Description

[CALL_END_TIME]

End time of the current call. If the call has not yet
ended, it is the current time. The time is read from the
agent’s PC clock.

[CALL_START_TIME]

Start time of the current call. If no call exists, this field
is empty. The time is read from the agent’s PC clock.

[COMPUTER_NAME]

Name of computer the agent is currently logged on to.

{LOCAL_PHONE_EXT]

Agent’s extension.

Alerting#

Number of the ringing phone.

Called#

Number of the phone that received a call.

Calling#

Number of the phone that made a call.

Original Called#

Original number that received a call.

Original Calling#

Original number that made a call.

Creating Set Enterprise Data Actions
This action enables you to set an enterprise data field variable in the Agent Desktop
enterprise data pane to a desktop variable or static text of your choosing.
The action is available only for the Ringing and Answered events.
NOTE: Do not include a Set Enterprise Data action in the same work
flow as the following Call Control actions: supervised transfer, blind
transfer, conference, or blind conference. This can cause a critical
race condition that results in the enterprise data not being available.
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To set up a Set Enterprise Data action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the Set Enterprise Data tab, then click New. The Set Enterprise Data
Action Setup Editor window appears (Figure 65).
Figure 65.

Set Enterprise Data Action Editor window

3. Complete the fields as follows:
Field

Description

Action Name

Name for the new action.

Enterprise Data
Field to Set

Enterprise variable that you want to set. Only
Unified ICM call variables and user-created ECC
variables are available for selection from the
drop-down list.

Source for the Data (choose one)
Desktop Variable

Name of desktop variable to use for the value of the
enterprise data field. Choices are Agent ID, System
Name, System Time, and Skill Group.

Static Text

Static text to use for the value of the enterprise data
field. Maximum length is 210 characters.

4. Click OK.
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Creating Timer Actions
The timer action triggers Agent State, HTTP, or Agent Notification actions after a given
amount of time has elapsed under certain circumstances. For instance, you can
configure the Timer action to change an agent’s state to Ready if the agent has been
in the Work Ready state for 3 minutes. This action is available to agents using Agent
Desktop at the Enhanced and Premium levels.
To set up a timer action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the Timer Action tab, then click New. The Timer Action Setup window
appears (Figure 66).
Figure 66.

Timer Action Setup window

3. Complete the Timer Action Setup window as follows:
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Field

Description

Action Name

Name for the new action.
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Field

Description

Timer Duration

Amount of time the agent must spend in the selected
agent state before the action executes.

Timer expiration work flow setup
Check box

(optional) Select the check box to enable a condition
regarding the agent state to the work flow setup.

Agent state is

(optional) Agent state must be equal to/not equal to
Ready/Not Ready.
Note: If you enable this condition, the agent state field
must not be empty. You must select Ready or Not
Ready.

Actions

Actions that will execute after timer duration expires.

4. Click Add to select the actions to be executed when the timer has expired.
5. When you are finished configuring the Timer Expiration Work Flow, click OK.

Utility Action
There are three utility actions:
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■

Start recording

■

Stop recording

■

Send a predefined, high-priority chat message to the agent’s supervisor
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High Priority Chat Messages
A high priority chat message is a predefined message that appears in a supervisor’s
Chat window (Figure 67). The message behaves just like a regular chat message that
is tagged as high priority—it pops up on the supervisor’s screen on top of all other
windows to attract the supervisor’s attention.
Figure 67.

Sample high-priority chat message

You can configure a task button on the Agent Desktop toolbar to send such a
message from an agent to the agent’s supervisor(s).
NOTE: Agents who use CAD-BE can send a high priority chat message
to their supervisor, but the supervisor cannot reply to the message,
because CAD-BE does not have chat capability.
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To set up a utility action:

1. Set up a new action (see page 97). The Select Action window appears.
2. Select the Utility Action tab, then click New. The Utility Action Setup window
appears (Figure 68).
Figure 68.

Utility Action Setup window

3. Type a name for the new action, select an action type from the drop-down list,
then click OK.
■

If you select Record as the action type, select Start or Stop from the
Action field.

■

If you select HighPriorityChat, type the message you want to send as the
predefined, high-priority chat message in the Message field.

NOTE: When the dialog box initially opens, only the Action Name and
Action Type fields are visible. When you choose the Record action
type, the Action field appears. When you choose the High Priority
Message action type, the Message field appears.
NOTE: If a Record action is part of a voice contact work flow, the
agent being recorded will see a recording icon in the contact
appearance pane even if notification is turned off.
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Cisco Unified Outbound Dialer
Cisco Unified Outbound Dialer is a Unified ICM/Unified Contact Center Enterprise
feature that enables automated outbound dialing to customers. These outbound calls
appear as inbound calls to the agent, and information about the call appears in the
Enterprise Data pane.
NOTE: Unified Outbound Dialer is available only for Agent Desktop.
NOTE: Cisco Unified Mobile Agent call-by-call mode does not support
Outbound Dialer. Nailed mode does support Outbound Dialer.
A supervisor or administrator sets up a calling campaign in Unified ICM that consists
of various elements that will present calls to agents and provide information so the
agent can handle the call successfully. (See the Cisco ICM/IP Contact Center
Enterprise Edition Setup and Configuration Guide for information on setting up calling
campaigns.)
Outbound Dialer has four modes that determine what type of dialing is done to make
the outbound calls:
■

Predictive Dialing Mode. In this mode, agents are reserved and a number of
customers are dialed simultaneously. When a customer is contacted, the call
is transferred to an available reserved agent. The customer’s data is
displayed in the agent’s Enterprise Data window. Predictive dialing mode
optimizes agent usage by calculating the average time an agent waits to
receive a call and their average call handling time to determine the number of
lines to dial per agent so that wait time is kept to a minimum.

■

Progressive Dialing Mode. This mode is similar to Predictive Dialing mode,
except that the system does not calculate the number of lines to dial per
agent. Rather, the user configures a fixed number of lines to be dialed per
agent.

■

Preview Dialing Mode. In this mode, an agent is reserved and then presented
with a call along with customer information in the Enterprise Data window.
Based on this information, the agent can accept, skip, or reject the call.

■

Direct Preview Dialing Mode. This mode is similar to Preview Dialing mode,
except that the agent can categorize the phone call presented as Voice,
Answering Machine, Invalid, and Fax Modem.
NOTE: For information on how Outbound Dialer dialing modes work
with Voice Contact work flows, see "Voice Contact Work Flows and
Outbound Dialer" on page 88.
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All four dialing modes use the personal callback feature. This features enables an
agent to reschedule a customer call at the customer’s request for a more convenient
time. Callbacks can be configured so that, when the call is redialed, the call is directed
to any agent (regular callback) or the call is directed to the agent who made the
callback reservation (personal callback). The callback type is configured at the
campaign level and is not controlled by the agent.

Outbound Dialer Actions
Based on the enterprise data information, the agent selects the appropriate Outbound
Dialer action button on the Outbound Dialer toolbar.
The available Outbound Dialer actions are:
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■

Accept. The system dials the customer and connects the call to the agent.

■

Reject. The system rejects the current call and releases the agent from the
outbound calling reservation. At this point, the system can deliver to the agent
either another outbound call or a new inbound call.

■

Reject Close. The system rejects the current call and closes the record so the
customer will not be called again.

■

Skip. The system skips the current call and presents the agent with another
customer call.

■

Skip Close. The system skips the current call and closes the record so the
customer will not be called again.

■

Skip Next. The system skips the call and displays a menu of these options:
—

Wrong Number. The agent is informed that the number called is a wrong
number. After the call terminates, the system calls other customer phone
numbers.

—

Not Home. The agent is informed that the customer is not home. After the
call terminates, the system calls other customer phone numbers.

■

Callback. Displays the Callback Properties dialog box, which the agent uses to
set a time and date to call back the customer. This action is enabled only if
the agent is in the talking or wrap-up agent state. The agent also uses this
dialog box to cancel a previously-scheduled callback of the current customer.
This action works only if the agent is in a talking or wrap-up state during a call
generated by Unified ICM.

■

Reclassify. Displays a menu that enables the agent to reclassify a customer
phone number as voice, answering machine, fax/modem, or an invalid
number.

■

Cancel Reservation. The system releases the agent from the calling campaign
and places the agent in the Not Ready state. To resume participating in the
calling campaign, the agent must change the agent state to Ready.
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Outbound Dialer Toolbar
In order for the Outbound Dialer actions to be available for agents to use, you must
configure the agent interface to include the Outbound Dialer toolbar. The dialing mode
used in the calling campaign determines which buttons appear in the toolbar
(Table 20).
Table 20.

Icon
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Outbound Dialer toolbar buttons and dialing mode in which they appear

Name

Dir. Preview

Predictive

Preview

Progressive

Accept

×

×

×

×

Reject

×

×

Reject Close

×

×

Skip

×

×

Skip Close

×

×

Skip-Next

×

×

×

×

Callback

×

×

×

×

Reclassify

×

Cancel Reservation

×

×

×

×

133

Cisco Desktop Administrator User Guide

To configure the Outbound Dialer toolbar to display in Agent Desktop:

1. In the User Interface window, select the Toolbar tab.
2. In the Outbound Dialer Mode section, select the check box next to the dialing
mode used by your calling campaign (Figure 69). The appropriate buttons are
enabled in the button selection pane.
Figure 69.

Toolbar tab of the User Interface window

3. Click Apply to save your changes. The Outbound Dialer toolbar will now appear
on the Agent Desktop interface.

Outbound Dialer Enterprise Data
In order for Outbound Dialer enterprise data to appear in the Enterprise Data window,
you must edit the Default layout to include some or all Outbound Dialer fields
(Table 21). All Outbound Dialer fields are prefixed with the letters “BA”.
For information about editing the Default layout, see "Layouts" on page 147.
Table 21.

Cisco Outbound Dialer enterprise data fields

Variable

Comment

BAAccountNumber [200]
BABuddyName [201]
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Table 21.

Cisco Outbound Dialer enterprise data fields (cont’d)

Variable

Comment

BACampaign [202]
BADialedListID [203]

Required for Preview and Direct Preview dialing modes
in order for the Skip function to work

BAResponse [204]
BAStatus [205]

Required for all dialing modes. If this field is not
included in the layout, no other Outbound Dialer fields
will be displayed.
If a call is part of a Preview dialing mode campaign, the
first letter in the BAStatus field entry is a P. If a call is
part of a Direct Preview dialing mode campaign, the
first letter is a D.

BATimeZone [206]
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Required for all dialing modes in order for the Callback
function to work.
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Getting Started with Desktop
Administrator

3

Introduction
Desktop Administrator is the web-based portion of CIsco Desktop Administrator. It
enables you to perform the following tasks:
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■

Configuring Enterprise Data (page 142)

■

Configuring Desktop and Server Monitoring and Recording (page 153)

■

Synchronizing Directory Services (page 159)

■

Configuring Agents (page 166)

■

Configuring Supervisors (page 168)

■

Configuring the Cisco Unified Presence Server (page 172)

■

Configuring the Cisco Unified Presence Cluster (page 175)

■

Configuring Contact Lists (page 177)

■

Configuring External Contacts (page 186)

■

Configuring Work Flow Groups (page 191)
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Accessing Desktop Administrator
You can access Desktop Administrator by either of two methods:
■

From the Desktop Work Flow Administrator menu bar

■

From your web browser

Only one person at a time can make changes in Desktop Administrator. Until a user
logs out or until that user’s login times out after 15 minutes of inactivity, other users
can only view information.
NOTE: If you close the browser or browser tab without first logging out
of Desktop Administrator, you will remain logged in an additional
15 minutes, when your login times out. For this reason it is important
that you log out before you close the browser or browser tab when
you are done using Desktop Administrator.
To log in to Desktop Administrator:

1. Access the Desktop Administrator login window by either of these two
methods:
■

From the Work Flow Administrator menu bar, choose Desktop
Administrator > Side A. If your system includes redundancy, you can also
choose Side B.

■

In your web browser, go to the following URL:
http://<CAD server>:8088/teamadmin/main.cda

The Desktop Administrator login window appears.
2. Enter your user name and password, and then click Login. The Desktop
Administrator home page appears.
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Using the Search Function
Most pages in Desktop Administrator include a search feature to help you find the
records you want to view or edit by filtering the displayed records according to criteria
you enter.
Searches are not case sensitive. For example, if you type a lowercase letter “s” in a
search field, the results will include all items that begin with the lowercase letter “s”
and the uppercase letter “S.”
To search for one or more records:

1. In the Search for field, enter your search criteria:
■

If you are searching for a text string, select the field name from the first
drop-down list box, a search pattern from the second drop-down list box,
and enter a text string in the third box.

■

If you are searching for a checked or cleared check box, select the check
box name in the first drop-down list box, and True (checked) or False
(cleared) in the second list box.

2. If necessary, complete any of the following actions.
■

If you want to add another criterion to the search query, click +. A new row
appears. Repeat step 1 for the new row.

■

If you want to remove the last criterion from the search query, click —. The
bottom row is deleted. If you click — and the search query only contains
one criterion, no change occurs.

■

If you want to remove all of the criteria from the search query, click
Clear Filter. All of the rows except the first row are deleted, and the first
row is reset to the default value.

3. When you are done creating your search query, click Find. A list of results that
match all of the criteria appears.
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4

Introduction
You can perform the following tasks in the Services Configuration node:

March 1, 2013

■

Configuring Enterprise Data (page 142)

■

Configuring Desktop and Server Monitoring and Recording (page 153)

■

Synchronizing Directory Services (page 159)

■

Releasing the Desktop Administrator Lock (page 160)
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Configuring Enterprise Data
The Enterprise Data node has two pages, the Fields page and the Layout List page.
You can perform the following tasks on the Fields page:
■

Creating a Custom Field (page 143)

■

Editing a Field (page 145)

■

Deleting a Field (page 146)

You can perform the following tasks on the Layout List page:
■

Creating a Custom Layout (page 147)

■

Copying a Layout (page 151)

■

Editing a Layout (page 152)

■

Deleting a Layout (page 152)

Enterprise data is information associated with an incoming call. It is displayed in the
Contact Management pane of Agent Desktop and CAD-BE, and on the Caller Data
screen in IP Phone Agent.
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Fields
Enterprise data fields and layouts are configured under the Enterprise Data node.
NOTE: The agent applications must be restarted for any enterprise
data variable or layout changes you make to go into effect.
The Field List displays both the predefined fields available for your switch type and the
custom fields you create.
■

Predefined fields have index numbers of 200–255. These fields are not
editable, with the exception of field 252, whose field name can be edited.
Note that when you click the Select All button, these fields are not selected.

■

Custom fields have index numbers of 0–199, and are editable.

Creating a Custom Field
To create a custom field:

1. Choose Services Configuration > Enterprise Data > Fields. The Field List page
appears (Figure 70).
Figure 70.
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2. Click Add New. The Add New page appears(Figure 71).
Figure 71.

Add New page

3. Complete the fields as described below.
Field

Description

Field Name

The variable’s field name. The field name and value can be
up to 29 characters long and can contain any character
except:
- ` ~ ! @ # $ % ^ & * ( ) - + = [ ] } { < > , / ? | \ \ : ; ' " and
space
If you use disallowed characters in the field name or value,
the enterprise data field might not display in the IP Phone
Agent service.
NOTE: If you are configuring an ECC variable, the
name must be prepended with a period (.).

Display
Name

The name that appears in desktop applications. The
display name can be up to 29 characters long and contain
any character except:
-`~!@#$%^&*()-+=[]}{<>,/?|\\:;'"
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Field

Description

Expanded
Call Context
(ECC)

Select the appropriate variable type from the drop-down
list:
• No: The field is not an ECC variable
• Scalar: A scalar ECC variable is one that stores a single
piece of data
• Array: An array ECC variable is one that stores multiple
pieces of data
If you selected array, choose the number of elements in
the array from the number field drop-down list.

Field Index

Choose a field index number from the drop-down list. The
field automatically shows the next available number.
If you selected Array in the ECC field, the Field Index field is
automatically disabled. The system will assign indexes to
each element in the array.

4. Click Save to save your changes. The field is added.
5. When you are finished adding fields, click Return to Field list.

Editing a Field
To edit a field:

1. Choose Services Configuration > Enterprise Data > Fields. The Field List page
appears (Figure 70).
2. If necessary, search for the field you want to edit. For instructions, see "Using
the Search Function" on page 139.
3. Select the field by clicking its name. The Field Information page for that field
appears.
4. Edit the field information as desired.
■

For predefined fields, you can edit only the display name.

■

For custom fields, you can edit all field information.

■

If you are editing an array field, the field index numbers assigned to the
array elements are listed, separated by commas.

5. When you are finished making changes, click Save, then click Return to Field
list.
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Deleting a Field
You cannot delete a predefined field. You can delete only custom fields.
If the field selected for deletion is the only field associated with a custom layout, you
cannot delete it until another field is added to the custom layout, or the layout itself
will be deleted. Either delete the custom layout, or add another field to it and then
delete the field you originally intended to delete.
If the field selected for deletion is the only field associated with a default layout, you
cannot delete it until another field is added to the default layout. Default layouts
cannot be deleted, and must always contain at least one field.
To delete a custom field:

1. Choose Services Configuration > Enterprise Data > Fields. The Field List page
appears (Figure 70).
2. If necessary, search for the field you want to delete. For instructions, see
"Using the Search Function" on page 139.
3. Select the check box corresponding to one or more custom fields, then click
Delete Selected. The selected fields are no longer displayed in the Field list.
4. You must click Save in order for the deletion to take effect.
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Layouts
The Layout List displays the field layouts available for use in the agent applications.
Each layout can contain up to 16 fields chosen from the Field List.
Cisco Agent Desktop automatically uses the default layout for call activity unless a
custom layout has been defined. See "Using a Custom Layout" on page 148 for more
information on what needs to be done to use a custom layout.
You cannot delete the default layout, but it can be edited to add or remove enterprise
data variables.
You can create up to 14 custom layouts in addition to the default layouts. Once the
limit of custom layouts is reached, the Add New and Copy buttons are disabled.

Creating a Custom Layout
To create a custom layout:

1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List
page appears (Figure 72).
Figure 72.
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2. Click Add New. The Add New page appears (Figure 71).
Figure 73.

Add New page

3. Enter a name for the layout. It must be unique and no longer than
16 characters, and it must be prepended with a period (.).
4. Use the arrow buttons to move selected fields between the Available and
Selected panes. Use the double arrow buttons to move all fields from one
pane to the other. Use the Up and Down buttons to change the order of the
fields in the Selected pane.
5. Click Save to save the custom layout. The layout is added to the Layouts list
page.
6. Repeat steps 3–5 to add another custom layout, if desired.
7. When you are finished adding custom layouts, click Return to Layout list.

Using a Custom Layout
If you want to use a custom layout, you must modify the .Layout field (field 252). This
defines the field as an ECC variable in Desktop Administrator. You must also create an
identical ECC variable in ICM Configuration Manager. The value of that ECC variable
can then be set in an ICM routing script to match the name of a layout created in
Desktop Administrator.
ECC variable values can also be set in an IP IVR script. Similarly, a local variable within
CVP Studio can be set with the layout name and that value passed back to the ICM
routing script and set equal to the layout ECC variable.
Example

This example illustrates how an ECC variable is used to specify a custom layout in an
ICM script to call a custom layout.
1. In Desktop Administrator, add a new field with the following attributes:
■

148

Field Name—Choose a name for the field. In this example, we use “.Layout”
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■

Expanded Call Context (ECC)—Select scalar ECC variable

■

Field Index—Select 252 from the list of available index numbers

2. Create a new custom layout. In this example, we have named the custom
layout “.acctinfo.” Note that the custom layout includes the ECC variable 252.
Figure 74.

New custom layout “.acctinfo”

3. In ICM Configuration Manager, define the ECC variable in the Expanded Call
Variable List. It must match what you defined in Desktop Administrator.
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NOTE: ICM requires the word “user” before the field name (so in this
example, the Layout field name becomes “user.Layout.”
Figure 75.
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4. Add the ECC variable to an ICM routing script. Use a Set Variable node in an
appropriate place in the ICM script to set the Layout ECC variable to the digit
string corresponding to the layout name in Desktop Administrator.
Figure 76.

Set Variable node in an ICM script that calls the custom layout “acctinfo”

Copying a Layout
1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List
page appears (Figure 72).
2. Select the layout you want to copy. The selected layout list page appears.
3. Click Copy.
4. Enter a name for the new layout and edit the fields as needed.
5. Click Save to save the copied layout. The layout is added to the Layouts list
page.
6. If desired, repeat steps 4 and 5 to create more new layouts.
7. When you are finished, click Return to Layout list.
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Editing a Layout
1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List
page appears (Figure 72).
2. Select the layout you want to edit. The selected layout list page appears.
3. Edit the layout as needed.
4. Click Save to save the edited layout.
5. Click Return to Layout list.

Deleting a Layout
You cannot delete a default layout. You can delete only custom layouts.
To delete a custom layout:

1. Choose Services Configuration > Enterprise Data > Layouts. The Layout List
page appears (Figure 72).
2. Select the check box corresponding to one or more custom layouts, then click
Delete Selected. The selected layouts are no longer displayed in the Layout
list. However, the actual deletion is not performed until you click Save.
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Configuring Desktop and Server Monitoring
and Recording
You can perform the following tasks on the VoIP Monitoring Device page of the Silent
Monitoring & Recording node:
■

Enabling Mobile Agent Monitoring (page 153)

■

Enabling Desktop Monitoring (page 154)

■

Configuring a Default Monitor Service (page 155)

■

Assigning Phone Devices to a Specific VoIP Monitor Service (page 156)

■

Removing a VoIP Monitor or Recording & Playback Service from Directory
Services (page 156)

The VoIP Monitoring Device page displays all phone devices configured in Unified CM.
If a phone is configured for extension mobility and a static extension is set up, the
Extension field displays the static extension assigned to the device’s MAC address. If
no static extension is set up, the Extension field is blank.
NOTE: Assign a static extension to an extension mobility device to
make administration easier.

Enabling Mobile Agent Monitoring
Mobile agents can connect to the system through any one of a number of agent
gateways. The Mobile Agent Monitor page (Figure 77) enables you to assign one Cisco
VoIP Monitor Service to each agent gateway. Only one Cisco VoIP Monitor Service per
agent gateway is supported. One Cisco VoIP Monitor Service can be assigned to
multiple agent gateways as well as to regular agent phones.
Figure 77.
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For mobile agent monitoring to work, the caller and agent voice gateways must be
separate. In addition, the VoIP Monitor server must be located in the network where it
can see the traffic flowing between the agents and customers. If the customer and
agent are speaking to each other over the same voice gateway, then that voice stream
will remain local to the gateway and not be exposed to the Cisco VoIP Monitor Service.
SPAN will not send those packets to the Cisco VoIP Monitor Service, and the
conversation will not be heard. For this reason, monitoring and recording of
Agent-to-Agent calls is not supported.
One additional limitation of mobile agent monitoring is that if a mobile agent logs in
while on a call or is on a call during a CAD services or CRI server failover, the agent
cannot be monitored until the call state changes or the agent makes a new call.
To enable mobile agent monitoring:

1. Choose Services Configuration > Silent Monitoring & Recording > Mobile
Agent. The Mobile Agent page appears.
2. Click Add New. A new row appears at the top of the list of existing mobile
agents.
3. Enter the agent gateway IP address to be monitored in the Agent Gateway IP
Address field, and then select the Cisco VoIP Monitor Service that will monitor
the agent gateway from the Monitor Service drop-down list.
4. Repeat steps 2 and 3 to add another mobile agent, if desired.
5. Click Save.
To disable mobile agent monitoring:

1. Choose Services Configuration > Silent Monitoring & Recording > Mobile
Agent. The Mobile Agent page appears.
2. Select the check box corresponding to one or more mobile agent gateways,
then click Delete Selected. The selected mobile agents will no longer be
displayed in the Mobile Agent list. However, the actual deletion is not
performed until you click Save.

Enabling Desktop Monitoring
When desktop monitoring is enabled, software on the agent desktop handles
recording and monitoring requests for that agent. This is possible only on desktops
that are physically connected to the network through a hard IP phone or through a soft
phone.
By default, desktop monitoring is enabled for all phone devices.
NOTE: Desktop monitoring does not function with some NIC cards
that are unable to detect both voice packets and data packets in a
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multiple VLAN environment. For more information on this issue, and
suggested work-arounds, see the Cisco CAD Installation Guide.
A phone is monitored either through desktop monitoring or a VoIP Monitor service—it
cannot be monitored by both. However, a VoIP Monitor service can be a backup if the
agent’s desktop monitoring module fails to register with Directory Services when
Agent Desktop is started.
To enable desktop monitoring:

1. Choose Services Configuration > Silent Monitoring & Recording > VoIP
Monitoring Device. The VoIP Monitoring Device page appears (Figure 78).
Figure 78.

VoIP Monitoring Device page

2. If necessary, search for the phone device for which you want to enable
desktop monitoring. For instructions, see "Using the Search Function" on
page 139.
3. Select the Enable Desktop Monitoring check box for the phone device and
click Save. Desktop monitoring is enabled for that device.

Configuring a Default Monitor Service
Select a default monitor service to avoid the possibility of having devices unassigned
to any monitor service. This situation can arise when there is more than one VoIP
Monitor service in the system.
NOTE: If your system has only one VoIP Monitor service, it is not
necessary to set a default monitor service or to manually assign each
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device to that single monitor service. The VoIP Monitor service
assumes that each device is assigned to it as the only available
monitor service.
Modifications you make on the VoIP Monitoring Device page go into effect immediately
after you save your changes.
To configure a default VoIP Monitor service:

1. Choose Services Configuration > Silent Monitoring & Recording > VoIP
Monitoring Device. The VoIP Monitoring Device page appears (Figure 78).
2. From the Default VoIP Monitor Service drop-down list, select the VoIP Monitor
service you want to be the default service.
3. Click Save.

Assigning Phone Devices to a Specific VoIP Monitor
Service
To assign a phone device to a specific VoIP Monitor service:

1. Choose Services Configuration > Silent Monitoring & Recording > VoIP
Monitoring Device. The VoIP Monitoring Device page appears (Figure 78).
2. If necessary, search for the phone device you want to assign to a VoIP Monitor
server. For instructions, see "Using the Search Function" on page 139.
3. Select the Selected check box for the device, then select the desired VoIP
Monitor service from the Monitor Service drop-down list.
■

To assign multiple devices, select the Selected check boxes for each
device, then select the desired VoIP Monitor service from the drop-down
list field above the list of devices, and then click Modify.

4. Click Save. The device or devices are now assigned to the specific VoIP
Monitor service.

Removing a VoIP Monitor or Recording & Playback
Service from Directory Services
The Remove VoIP/Recording/Playback Services page enables you to remove a VoIP
Monitor service or Recording & Playback service from Directory Services and
unregister it from the LRM service.
Remove these services only if you intend to uninstall (or already have uninstalled) the
VoIP Monitor service or Recording & Playback service permanently. The Remove
option enables you to clean up Directory Services.
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To remove a VoIP Monitor or Recording & Playback service from Directory Services:

1. Choose Services Configuration > Silent Monitoring & Recording > Remove
VoIP/Recording & Playback Services. The Remove VoIP/Recording & Playback
Services page appears (Figure 79).
Figure 79.

Remove VoIP/Recording & Playback Services page

2. From the appropriate drop-down list, select the service to be removed, and
then click Remove. The service is removed from Directory Services.
When you remove a VoIP Monitor service from Directory Services, it also removes that
service from the list of available VoIP Monitor services on the VoIP Monitoring Device
page as well (Figure 78). This can result in devices becoming unmonitored.
If the selected VoIP Monitor service has been set as the default service, you are
notified that this situation exists when you click Remove. When you click OK to confirm
that you want to remove the default VoIP Monitor service, any device that was
monitored by the default service will now be unmonitored. It is recommended that you
select another VoIP Monitor service to be the default. See "Configuring a Default
Monitor Service" on page 155 for more information.
If the VoIP Monitor service was selected to monitor specific devices, when you click OK
the following can occur:
■

The devices will be monitored by the default VoIP Monitor service (if one is
configured)

■

The devices will be monitored by desktop monitoring, if the Enable Desktop
Monitoring check box is selected for each device

■

The devices will be unmonitored

If devices become unmonitored, search for them on the VoIP Monitor Devices page
and reassign them to the default monitor, a specific monitor, or enable desktop
monitoring.
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To restore a removed service to Directory Services:

1. Start the removed service.
■

If you uninstalled the service, reinstall it. See the Cisco CAD Installation
Guide for information on installing CAD services.

■

If you have not uninstalled the service, stop the service and then restart
it, using the Windows Services utility in Control Panel.

2. In Desktop Administrator, click the VoIP Monitoring Device node again. The
refreshed page shows that the service is restored to the list of available
services.

158

March 1, 2013

Synchronizing Directory Services

Synchronizing Directory Services
The Directory Services database should be synchronized with the master Unified CCX
agent database. The databases are synced automatically whenever the master
Unified CCX database changes. However, you can manually sync them with the
Synchronize Directory Services command.
NOTE: You can also synchronize Directory Services manually from
Work Flow Administrator. See "Synchronizing Directory Services" on
page 159 for more information.
To synchronize the databases manually:

1. Choose Services Configuration > Synchronize Directory Services. The
Synchronize Directory Services page appears (Figure 80).
Figure 80.

Synchronize Directory Services page

2. Click Synchronize. The databases are synchronized, and you will see the
message, “Transaction successful” when the process is complete.
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Releasing the Desktop Administrator Lock
Use the Force-release CDA Lock page to forcibly unlock Desktop Administrator in the
event it remains locked even though no one is currently using it. This can occur if a
user closes the browser without logging out of Desktop Administrator, and the lock
does not automatically release after 15 minutes of inactivity.
It is recommended that you do not use the force-release option to lock out another
user. However, if this happens, the other user will be able to save anything currently
being modified. After the user has clicked Save, he or she will be locked out and will
be unable to make any more modifications until you have logged out.
Figure 81.

Force-release CDA Lock page

To forcibly unlock Desktop Administrator:

1. Choose System Configuration > Force-Release CDA Lock. The Force-Release
CDA Lock page appears (Figure 81).
2. Click Release Lock. The lock on the application is released and you can now
view and modify data.
NOTE: In a High Availability system, you must be logged in to the side
on which Desktop Administrator was locked. If Desktop Administrator
was locked by someone who logged in on Side A, you cannot unlock it
if you are logged in on Side B.
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5

Introduction
The Agent Re-skilling page under the Unified CCE Configuration node (Figure 82)
enables you to configure the web sites that supervisors use to dynamically re-skill the
agents on their teams.
By default, no web sites are configured and supervisors use the Cisco Unified Contact
Center Enterprise Web Administration Agent Re-skilling website. However, you can
specify alternate web sites to be used to re-skill agents on the Agent Re-skilling page.
Figure 82.
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Alternate Agent Re-skilling Websites
You can specify two alternate agent re-skilling web sites to appear in the Tools menu
of Cisco Supervisor Desktop (Figure 83).
Figure 83.

Agent Re-skilling in the Cisco Supervisor Desktop Tools menu

By default, these menu options both lead to the Cisco Unified Contact Center
Enterprise Web Administration Agent Re-skilling website on Unified ICM.
To set up an alternate agent re-skilling website:

1. Choose Unified CCE Configuration > Agent Re-skilling. The Agent Re-skilling
page appears (Figure 82).
2. For the desired site (Site1 and/or Site2), clear the Use Cisco’s Re-skilling Tool
check box and then type the URL of the alternate re-skilling website in the
URL field.
3. Click Save.
To remove an alternate agent re-skilling website:

1. Choose Unified CCE Configuration > Agent Re-skilling. The Agent Re-skilling
page appears (Figure 82).
2. Select the Use Cisco’s Re-skilling Tool check box for the desired site.
3. Click Save.
NOTE: When you select the check box, the URL field is disabled.
When you click Save, the URL field is cleared.
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■

Website changes do not take effect until Supervisor Desktop is restarted.

■

Any URL you enter is not checked by the system for accuracy.

■

You can enter up to 256 characters in the URL field.

■

You can enter any type of URL (for example, http, https, file, or ftp).
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6

Introduction
You can use Personnel Configuration to view information about agents and
supervisors within a logical contact center. You can also use Personnel Configuration
to change supervisor passwords and to assign agents to work flow groups.
NOTE: Some agent, supervisor, and team properties are configured
in Cisco Unified Intelligent Contact Management (Unified ICM) and
are only viewable, not editable, from within Desktop Administrator.
The Personnel Configuration node allows you do to the following tasks:
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■

Configuring Agents (page 166)

■

Configuring Supervisors (page 168)
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Configuring Agents
The Agents window displays a list of all agents configured in Unified ICM. You can view
an agent’s name, login ID, login name, team, and work flow group assignment on this
page.
An agent can belong to only one work flow group at a time. By default, all agents are
assigned to the Default work flow group. The only thing you can change on this page is
the agent’s work flow group assignment.

Changing an Agent’s Work Flow Group Assignment
To change an agent’s work flow group assignment:

1. Choose Personnel > Agents. The Agents List page appears (Figure 84).
Figure 84.

Agents List page

2. If necessary, search for the agent whose work flow group assignment you
want to change. For instructions, see "Using the Search Function" on
page 139.
3. Select the desired work flow group from the Work Flow Group drop-down list
field in the agent’s row.
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■

To assign multiple agents to a work flow group, select the Selected check
boxes for each agent, then select the desired work flow group from the
drop-down list field above the list of agents, and then click Modify.

4. Click Save. The agent or agents are now assigned to the specified work flow
group.
NOTE: If a recently-added work flow group does not appear in the
drop-down list, or a recently-deleted work flow group does appear in
the drop-down list, refresh the page by clicking the
Personnel > Agents link again.
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Configuring Supervisors
The Supervisors page (Figure 85) displays a list of all supervisors configured in Unified
ICM. You can view the supervisor’s name, ID, and login name on this page. When you
select a specific supervisor from the list, you can view that supervisor’s properties.
You can also reset the supervisor’s password from the Supervisors window.
Figure 85.

Supervisors window

Viewing a Supervisor’s Properties
You can view a supervisor’s properties as set up in Unified ICM.
To view a supervisor’s properties:

1. Choose Personnel > Supervisors. The Supervisors list page appears
(Figure 85).
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2. If necessary, search for the supervisor whose properties you want to view. For
instructions, see "Using the Search Function" on page 139. The supervisor’s
properties appears (Figure 86).
Figure 86.

Supervisor Properties window

3. To return to the Supervisors list page, click Return to Supervisor LIst or the
blue arrow at the top of the page.

Resetting a Supervisor’s Password
By default, supervisors set their own passwords the first time they access Cisco
Supervisor Desktop. It is possible that a supervisor will be unable to remember the
password the supervisor set up. You can reset the password so that the supervisor
can log in and set up a new password.
If a password has been set up by either you or a supervisor, it appears as a string of
placeholder symbols in the Password field. If the field is blank, no password has been
set up for that supervisor.
To reset a supervisor’s password:

1. Choose Personnel > Supervisors. The Supervisors list page appears
(Figure 85).
2. If necessary, search for the supervisor whose password you want to reset. For
instructions, see "Using the Search Function" on page 139.
3. In the password field, type a new password and then click Save. The
supervisor’s password is reset to the string you entered.
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7

Introduction
The Cisco Unified Presence Settings node in Desktop Administrator gives
administrators the ability to integrate Cisco Unified Presence with CAD.
Integrating Unified Presence with CAD makes it possible for supervisors using
Supervisor Desktop and agents using Agent Desktop to view the availability of
non-agents using Unified Presence Client or Microsoft Office Communications Server
(MOCS). This feature enables supervisors and agents to initiate chat sessions with
subject matter experts (SMEs) who can provide information that can help agents
assist customers more quickly and effectively.
For more information about Cisco Unified Presence, see the description at the
following URL:
http://www.cisco.com/en/US/products/ps6837/index.html
Integrating a Unified Presence cluster with CAD consists of the following tasks.
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■

Configuring the Cisco Unified Presence Server (page 172)

■

Configuring the Cisco Unified Presence Cluster (page 175)

■

Configuring Contact Lists (page 177)

■

Configuring External Contacts (page 186)

■

Configuring Work Flow Groups (page 191)
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Configuring the Cisco Unified Presence Server
The Cisco Unified Presence server must be configured to accept inbound requests
from agent devices so that, when an agent logs into CIsco Agent Desktop, the agent’s
computer will be able to connect to the Cisco Unified Presence server.
To enable this connection, an inbound Access Control List (ACL) must be configured to
allow inbound messages from the agent computer’s IP address or to allow all inbound
messages.
To configure the Unified Presence server:

1. Access Cisco Unified Presence Administration.
2. Navigate to System > Security > Incoming ACL.
3. Create an incoming ACL with the address pattern set to either the agent PC’s
IP address or to ALL.
For more detailed information on configuring an ACL, see the topic, “Configuring
System Information on Cisco Unified Presence” in the Configuration and Maintenance
Guide for Cisco Unified Presence Release 7.0, available at www.cisco.com.
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Configuring Unified Presence Users
In order to use Unified Presence from within Agent Desktop, all agents must be
Unified Presence users who have the following attributes:
■

An end user, not an application user

■

Licensed as CUP (Cisco Unified Presence) Enabled

■

Licensed as CUPC (Cisco Unified Personal Communicator) Enabled

■

Associated with the same LDAP profile with which SMEs are associated

To enable a Unified Presence user for CUP and CUPC:

1. In CIsco Unified CM Administration, navigate to System > LIcensing >
Capabilities Assignment.
2. Search for the Unified Presence user.
3. On the Unified Presence user’s Capabilities Assignment Configuration page,
select the Enable CUP and Enable CUPC check boxes in the Capabilities
Assignment Information section of the page.
4. Click Save.
To associate the Unified Presence user with the LDAP profile:

1. In Cisco Unified CM Administration, navigate to Application > Cisco Unified
Personal Communicator > User Settings.
2. Search for the Unified Presence user.
3. On the Unified Personal Communicator User Settings page, ensure that the
LDAP profile assignment is the same as that for SMEs.
The LDAP profile cannot have anonymous bind enabled. If it is, it results in partial data
when searching for SMEs.
If the LDAP profile is configured by host name, make sure you can ping it from the CAD
Base services server or the Unified CCE server.
If the CUP server is configured by host name, make sure you can ping it from the
Unified CCE server, CAD Base services server, or agent desktop machine.
To ensure that the LDAP profile is not configured with anonymous bind:

1. IN Cisco Unified Presence Administration, navigate to Application > Cisco
Unified Personal Communicator > LDAP Profile.
2. Search for the appropriate LDAP profile (the profile to which all the SMEs are
assigned).
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3. On the LDAP Profile Configuration page, ensure that the Anonymous Bind
check box on the right side of the page is cleared.
4. Click Save.
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Configuring the Cisco Unified Presence
Cluster
The first task in integrating CAD with a Unified Presence cluster is configuring the
cluster by specifying the connection information.
NOTE: It is assumed that all of the agents are managed in one
Unified Presence cluster.
To configure the Unified Presence cluster:

1. Choose Cisco Unified Presence Settings > Cisco Unified Presence Cluster
Settings. The Cisco Unified Presence Cluster Settings page appears
(Figure 87).
Figure 87.

Cisco Unified Presence Cluster Settings page

2. Complete the fields as described below.
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Field

Description

Enable Cisco
Unified Presence
Integration

Select to enable communication between supervisors
and agents and non-agents.

Version

Version of Cisco Unified Presence.

Publisher
Host/IP Address

Hostname or IP address of Unified Presence server
(the publisher if you have a Unified Presence cluster).
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Field

Description

Presence User
Login ID

The login ID of a Unified Presence end user. This user
must be:
• An “end user,” not an “application user”
• CUP-enabled
• CUPC-enabled
• Associated with the same LDAP profile that SMEs
are associated with

Password

Password for the Presence User Login ID user.

Subscriber
Host/IP
Addresses

If you have a Unified Presence cluster, the hostname
or IP address of the Unified Presence subscriber(s).

3. Click Verify to confirm that the information you entered is correct. Desktop
Presence Administrator connects to the Unified Presence server using the
hostname or IP address, login ID, and password you entered.
4. Click Save to save your changes.
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Configuring Contact Lists
A contact list consists of the SMEs that you want to make available to agents who use
Agent Desktop. Agents and supervisors see the SMEs in the Contact Selection window
after clicking the Chat button when the Presence feature is enabled. An agent only
sees the SMEs who are assigned to the agent’s work flow group. A supervisor,
however, sees all of the SMEs in all of the work flow groups that are associated with
the supervisor’s teams.
NOTE: Agents and supervisors must restart Agent Desktop and
Supervisor Desktop to see any changes you make to contact lists.
Unified Presence can be configured to allow you to assign up to 100 SMEs to a
contact list in Unified Presence 6.0, and up to 200 SMEs to a contact list in Unified
Presence 7.0 or higher.
Use the Contact Lists node to complete the following tasks.
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■

Creating a Contact List (page 178)

■

Finding a Contact List (page 179)

■

Deleting a Contact List (page 179)

■

Editing a Contact List (page 180)

■

Adding SMEs to a Contact List (page 181)
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Creating a Contact List
To create a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists
page appears (Figure 88).
Figure 88.

Contacts Lists page

2. Create a new contact list by clicking Add New. The Add New page appears
(Figure 89).
Figure 89.
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Add New page
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3. Type a name in the Contact List Name field and a description in Contact List
Description.
4. Click Save, then click Return to Contact list. The Contact Lists page reappears
with the new contact list.
NOTE: A contact list name has a maximum of 64 characters.

Finding a Contact List
You can search for a contact list from any of the following pages.
■

Contact Lists page. Navigate to this page by choosing Cisco Unified Presence
Settings > Contact Lists.

■

Work Flow Groups page. Navigate to this page by choosing Cisco Unified
Presence Settings > Work Flow Groups, then selecting a work flow group.
NOTE: Searches are not case sensitive. For example, if you type a
lowercase letter “s” in a search field, the results will include all items
that begin with the lowercase letter “s” and the uppercase letter “S.”

To find a contact list:

1. Select a descriptor from the Search for drop-down list, then type one or more
characters in the text field.
2. If necessary, complete any of the following actions.
■

If you want to add another condition to the search query, click +. A new
row containing a field drop-down list, a descriptor drop-down list, and a
text field appears. Repeat step 1 for the new row.

■

If you want to remove the last condition from the search query, click —.
The bottom row is deleted. If you click — and the search query only
contains one condition, no change occurs.

■

If you want to remove all of the conditions from the search query, click
Clear Filter. All of the rows except the first row are deleted, and the first
row is reset to the default value.

3. When you are done creating your search query, click Find. A list of contact
lists that match all of the conditions appears.

Deleting a Contact List
To delete a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists
page appears (Figure 88).
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2. If necessary, search for the contact list you want to delete. For instructions,
see "Finding a Contact List" on page 179.
3. Select the check box that corresponds to the contact list you want to delete,
then click Delete Selected. The selected contact list is no longer displayed in
the list of contacts. However, the actual deletion is not performed until you
click Save.

Editing a Contact List
To edit a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists
page appears (Figure 88).
2. If necessary, search for the contact list you want to edit. For instructions, see
"Finding a Contact List" on page 179.
3. Select the contact list by clicking its name. The page for that specific contact
list appears (Figure 90).
Figure 90.

Contacts List page — specific list

4. Complete one or both of the following operations.
■

If you want to remove one or more SMEs from the contact list, clear the
corresponding check boxes in the Included column.

■

If you want to change the description of the contact list, type the new
description in the Contact List Description field.

5. When you are finished making changes, click Save, then click Return to
Contact list.
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Adding SMEs to a Contact List
Desktop Administrator searches the Unified Presence LDAP server for SMEs, and
when found, saves them to the CAD LDAP server.
NOTE: If you want to provide access to users in an external
environment who are not managed by the Unified Presence LDAP
server, you can add them manually as external contacts. For
instructions, see "Adding External Contacts" on page 186.
To add SMEs to a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists
page appears (Figure 88).
2. Select a contact list by clicking its name. The page for that specific contact list
appears. If the contact list you selected does not include any SMEs, the
Subject Matter Expert List will be empty (Figure 91).
Figure 91.

March 1, 2013

Specific contact list page with no SMEs
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3. Find the SME you want to add using the Search function. For instructions
about finding SMEs, see "Finding SMEs" on page 182.Figure 92 shows the
SMEs whose last name begins with the letter “s” and also contains the
letter “c.”
Figure 92.

Specific contact list page with SMEs

4. Select the SMEs you want to add to the contact list.
■

To add all of the SMEs that are displayed, click Select All.

■

To add SMEs individually, select the corresponding check box in the
Included column.

5. If you want to find and add other SMEs, repeat steps 3 and 4.
6. When you are done adding SMES, click Save, then click Return to Contact list.

Finding SMEs
NOTE: Searches are not case sensitive. For example, if you type a
lowercase letter “s” in a search field, the results will include all items
that begin with the lowercase letter “s” and the uppercase letter “S.”
NOTE: You can only search for SMEs from the page of a specific
contact list.
To find SMEs:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists
page appears.
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2. Select a contact list by clicking its name. The page for that specific contact list
appears.
3. If you do not want the search results to include SMEs who are already in the
current contact list, select Included from the Search for field drop-down list
and False from the criterion drop-down list, then click +. A new condition with
default values (Included and True) is added to the search query (Figure 93).
NOTE: If you use the Included field in a search condition, you must
add a second condition that uses the Last Name or First Name field.
You cannot search using the Included field alone.
Figure 93.
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Search query with two conditions (default)
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4. Select either Last Name or First Name from the field drop-down list and a
descriptor from the drop-down list, then type one or more characters in the
search field (Figure 94).
Figure 94.

Search query with two conditions

NOTE: You can also leave the Last Name and First Name fields blank
in order to find all SMEs, or all SMEs who fit your other search criteria.
If the search returns more than 500 results, only the first 500 will be
displayed.
5. If necessary, complete any of the following actions.
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■

If you want to add another condition to the search query, click +. A new
row containing a field drop-down list, a descriptor drop-down list, and a
text field appears. Repeat step 4 for the new row.

■

If you want to remove the last condition from the search query, click —.
The bottom row is deleted. If you click — and the search query only
contains one condition, no change occurs.

■

If you want to remove all of the conditions from the search query, click
Clear Filter. All of the rows except the first row are deleted, and the first
row is reset to the default value.
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6. When you are done creating your search query, click Find. A list of SMEs that
match all of the conditions appears (Figure 95).
Figure 95.
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Search query with results
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Configuring External Contacts
If you have an external environment with subject matter experts who do not use Cisco
Unified Personal Communicator but who do use Microsoft Office Communicator
(MOC), you can use the External Contacts feature to provide access to those
additional users.
Use the External Contacts node to complete the following tasks.
■

Adding External Contacts (page 186)

■

Finding an External Contact (page 188)

■

Editing an External Contact (page 189)

■

Deleting an External Contact (page 189)

Adding External Contacts
To add an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External
Contacts page appears (Figure 96).
Figure 96.
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External Contacts page
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2. Click Add New. The Add New page appears (Figure 97).
Figure 97.

Add New page

3. Complete the fields as described below.
Field

Description

Last Name

Optional. Maximum of 128 characters. No restrictions on
the characters that can be entered.

First Name

Optional. Maximum of 128 characters. No restrictions on
the characters that can be entered.

URI

Uniform Resource Indicator. Required. No restrictions on
the length or characters that can be entered.

Phone
Number

Optional. No restrictions on the length or characters that
can be entered.

4. Click Save to save your changes. The external contact is added.
NOTE: After you click Save, you cannot edit the URI field. If you want
to change the URI of an existing external contact, you must delete the
external contact and create a new external contact with the new URI.
5. If you want to create additional external contacts who have similar
information, click Copy, edit the fields as needed, then click Save.
6. When you are finished adding an external contact, click Return to External
contact list.
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Finding an External Contact
NOTE: Searches are not case sensitive. For example, if you type a
lowercase letter “s” in a search field, the results will include all items
that begin with the lowercase letter “s” and the uppercase letter “S.”
To find an external contact user:

1. Choose Cisco Unified Presence Settings > External Contacts. The External
Contacts page appears (Figure 96).
2. Select a field (for instance, Last Name) and a descriptor (for instance, Begins
With), then type one or more characters in the text field.
3. If necessary, complete any of the following actions.
■

If you want to add another condition to the search query, click +. A new
row containing a field drop-down list, a descriptor drop-down list, and a
text field appears. Repeat step 2 for the new condition.

■

If you want to remove the last condition from the search query, click –.
The bottom row is deleted. If you click – and the search query only
contains one condition, no change occurs.

■

If you want to remove all of the conditions from the search query, click
Clear Filter. All of the rows except the first row are deleted, and the first
row is reset to the default value.

4. When you are done creating your search query, click Find. A list of external
contacts that match all of the conditions appears (Figure 98).
Figure 98.

188

External Contact— search query and results
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Editing an External Contact
To edit an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External
Contacts page appears (Figure 96).
2. If you do not see the external contact you want to edit, use the search
function to find the contact. For instructions, see "Finding an External
Contact" on page 188.
3. Select an external contact by clicking the user’s last name. The page for the
specific external contact (Figure 99).
Figure 99.

External Contact page — specific user

4. Change the user’s last name, first name, or phone number by typing new
information in the corresponding field.
5. When you are finished making changes, click Save, then click Return to
External Contacts list.

Deleting an External Contact
To delete an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External
Contacts page appears (Figure 96).
2. If necessary, search for the external contacts that you want to delete. For
instructions, see "Finding an External Contact" on page 188.
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3. Select the check box corresponding to one or more external contacts, then
click Delete Selected. The selected external contacts are no longer displayed
in the list of external contacts. However, the actual deletion is not performed
until you click Save.
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Configuring Work Flow Groups
Use the Work Flow Groups node to add the contact lists that you create to work flow
groups. You can assign up to 25 contact lists to a work flow group. For the limits on
the number of SMEs in a contact list, see "Configuring Contact Lists" on page 177.
NOTE: You cannot create work flow groups or assign work flow
groups to agents in Desktop Administrator. You must create and
assign work flow groups in Desktop Work Flow Administrator.
Use the Work Flow Groups node to complete the following tasks.
■

Finding a Work Flow Group (page 191)

■

Adding a Contact List to a Work Flow Group (page 192)

■

Selecting Agents to Appear Offline (page 194)

Finding a Work Flow Group
NOTE: Searches are not case sensitive. For example, if you type a
lowercase letter “s” in a search field, the results will include all items
that begin with the lowercase letter “s” and the uppercase letter “S.”
To find a work flow group:

1. Choose Cisco Unified Presence Settings > Work Flow Groups. The Work Flow
Groups page appears (Figure 100).
Figure 100.
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2. Create a search query using one or more conditions as described below.
■

If you want to search for work flow groups by name, select Work Flow
Group from the field drop-down list and any item from the criterion
drop-down list, then type one or more characters in the text field.

■

If you want to search for work flow groups for which agents appear offline,
select Agents appear offline from the field drop-down list and True from
the criterion drop-down list.

■

If you want to add another condition to the search query, click +. A new
row containing the field drop-down list, the descriptor drop-down list, and
the text field appears. Define the new condition as described above.

■

If you want to remove the last condition from the search query, click –.
The bottom row is deleted. If you click – and the search query only
contains one condition, no change will occur.

■

If you want to remove all of the conditions from the search query, click
Clear Filter. All of the rows except the first row are deleted, and the first
row is reset to the default value.

3. When you are finished creating your search query, click Find. A list of work
flow groups that match all of the conditions appears.

Adding a Contact List to a Work Flow Group
To add a contact list to a work flow group:

1. Choose Cisco Unified Presence Settings > Work Flow Groups. The Work Flow
Groups page appears (Figure 100).
2. If necessary, search for the work flow group to which you want to add a
contact list. For instructions, see "Finding a Work Flow Group" on page 191.
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3. Select a work flow group by clicking the name of the group. The page for the
selected work flow group appears(Figure 101).
Figure 101.

Specific work flow group page

4. If necessary, search for the contact lists you want to add to the selected work
flow group. For instructions, see "Finding a Contact List" on page 179.
5. Add up to 25 contact lists by selecting the corresponding check boxes in the
Included column (Figure 102). To select all of the contact lists, click Select All.
Figure 102.

Specific work flow group page — several contact lists selected

6. Repeat step 4 and step 5 if you want to find and add additional contact lists
to the selected work flow group.
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7. When you are finished adding contact lists, click Save, then click Return to
Work Flow Group list.

Selecting Agents to Appear Offline
You can configure agents within a work flow group to appear as offline to SMEs in the
Contact Selection window.
To select agents within a work flow group to appear offline:

1. Choose Cisco Unified Presence Settings > Work Flow Groups. The Work Flow
Groups page appears (Figure 100).
2. Select the Agents appear offline check box that corresponds to the work flow
group that contains the agents you want to appear as offline in the Chat
Selection window.
3. Click Save when finished.
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Question
Answer
Question
Answer

Question
Answer

Question
Answer

A

Where are global phone books stored?
They are stored in the Directory Services (LDAP) database.
How are phone books synchronized between the active and standby Directory
Services in a redundant system?
Whenever an entry is made in the active Directory Services, it is immediately
replicated on the standby system so that they remain synchronized.
Which logs should be collected to troubleshoot issues with global phone books?
The Cisco Agent Desktop and Cisco Desktop Administrator logs (agent.log and
administrator.log) and debug traces, set to the DEBUG level, (agent.dbg and
administrator.dbg) are used to troubleshoot phone book issues.
Where are global phone books configured?
Global phone books are created and populated by the administrator using Cisco
Desktop Administrator. Agents cannot edit global phone books. They can edit their
own employee phone books using Cisco Agent Desktop.
The administrator can enable and disable all phone books, or just employee
phone books. See "Phone Books" on page 39 for instructions on administering
phone books.

Question
Answer
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Do phone books run from the Directory Services database?
Earlier versions of CAD loaded phone books from Directory Services every time
the agent launched the dial pad. The current version of CAD loads phone books
once and stores them in memory to avoid delays.
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Question

Answer
Question
Answer
Question

Can global phone books be linked back into the Cisco Unified Communications
Manager/Unified CallManager LDAP user list so that it is available from the
IP phone corporate directory?
No.
Are phone books available to agents when they use their non-ACD extension?
No.
Is there a maximum number of entries that can be put into a phone book?

Answer

Yes. All phone books are limited to 3,000 entries each. The total number of phone
book entries supported in all phone books is 10,000.

Question

Can a global phone book be locked down so that only members of a certain team
can view it?
No, global phone books are either available to all agents or no agents. However,
there are work flow group phone books that are available to agents that are
assigned to that particular work flow group. If a team is assigned to a work flow
group, and there is a specific phone book for that work flow group, than no other
teams can view that particular phone book. See "Phone Books" on page 39 for
more information on the various types of phone books.
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B

Overview
The Cisco Desktop Monitoring Console is a Java application that monitors the status
of the CAD services and Directory Services (LDAP).
The Monitoring Console requires Tomcat to run. Tomcat is automatically installed with
the CAD base services.
NOTE: The Monitoring Console is installed automatically when the
CAD base services are installed. There is some manual setup and
configuration that is required. See the Cisco CAD Installation Guide
for more information.
The Monitoring Console application is located on any computer where the CAD base
services are installed. The URL for a hyperlink to the application is the following,
where <CAD server> is the IP address for the server on which the CAD base services
are installed:
http://<CAD server>:8088/smc/monitor.jsp
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Using the Monitoring Console
The Monitoring Console consists of 2 panes. The left pane displays a list of CAD
servers and the CAD services located on those servers. The right pane displays either
a summary view or a detail view of service status.
The summary view is displayed when you select the IP address of a server from the
left pane (Figure 103). The detail view is displayed when you select a specific service.
Figure 103.

198

Cisco Desktop Monitoring Console, summary view (top) and detail view (bottom)
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Status of the services is indicated also by a colored icon next to each service in the
left pane. If the service is running, a green circle is displayed; if the service is down, a
red circle with a white X through it is displayed.
If a server is down, a gray computer with a white X through it is displayed.
NOTE: Currently, the summary view and the detail view display the
same information in different ways. In the future, more service details
will be added to the detail view.
The information displayed, including the server list in the left pane, is refreshed every
15 seconds. It can also be manually refreshed at any time by clicking the Refresh
Server List button.

March 1, 2013

199

Cisco Desktop Administrator User Guide

200

March 1, 2013

B

Glossary

This glossary includes information for the following entries:
■

A (page 201)

■

B (page 203)

■

D (page 206)

■

E (page 207)

■

H (page 208)

■

I (page 208)

■

L (page 209)

■

M (page 210)

■

N (page 211)

■

P (page 211)

■

R (page 212)

■

S (page 213)

■

T (page 214)

■

U (page 215)

■

V (page 215)

■

W (page 216)

A
ACD
See automatic call distribution.
action
An occurrence that takes place when a rule is met. More than one action can take
place as a result of meeting a rule.
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administrator
The person who administers CAD. The administrator defines work flows and
teams, and the look and feel of the agent’s desktop.
agent
The person who interacts with customers in a contact center.
Agent Desktop
The Cisco desktop application used by a contact center agent to handle customer
calls.
agent state
An agent’s current ACD status. Possible statuses are Ready, Not Ready, Work
Ready, Work Not Ready, Reserved, Hold, Talking, and Logged Out.
Agent State action
An action type that changes an agent’s ACD agent state.
Always on Top mode
A display mode in which the interface is always on top of all other windows and
does not minimize.
Always Open mode
A display mode in which the interface is always visible, but might be hidden by
other open applications.
ANI
See automatic number identification.
area code
A 3-digit code designating a toll center in the United States and Canada.
array variable
A Unified ICM extended call context (ECC) variable that stores multiple pieces of
data.
automatic call distributor (ACD)
Optional software that resides on the PBX. Its role is to monitor various
parameters within the system and call center and to intelligently route calls based
on that information.
automatic number identification (ANI)
A series of digits at the front of a phone call that delivers the billing number (which
is not necessarily the phone number) of the caller.
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B
barge-in
A feature in Supervisor Desktop that allows a supervisor to forcibly join an agent’s
call with a customer. It is a forced conference call.
bridged appearance
A situation in which two devices share the same phone number (for example, a
secretary whose phone can also answer the supervisor’s phone).
Browser and IP Phone Agent (BIPPA) Service
See Cisco Browser and IP Phone Agent (BIPPA) Service.

C
CAD-BE
Cisco Agent Desktop—Browser Edition. A Java applet version of Agent Desktop
that runs in a web browser.
call activity data
The information displayed Agent Desktop documenting the length of time a call is
at a particular type of device or agent within the call center.
call center
A location where calls are made and answered. A call center typically has
numerous agents and an automatic call distributor.
call control
The action of changing the state of a call, for instance, making, answering,
transferring, or dropping a call.
Call Control action
An action that performs a call control function triggered by an event meeting a
rule. Call control actions vary according to switch type.
call history
See call activity data.
call log
The record of calls made and received by a desktop while running Agent Desktop.
call routing
The automatic sending of calls to the desired destination, such as an extension or
a queue.

March 1, 2013

203

Cisco Desktop Administrator User Guide

caller input
Touch tone data entered by the caller in response to prompting.
CallManager
A Cisco software-based voice over IP telephone switch.
Chat
A feature of Agent Desktop and Supervisor Desktop that enables agents and
supervisors to communicate via an instant messaging window.
Chat Service
See Cisco Chat Service.
chat session
A written exchange between agents or between agent and supervisor using the
Chat application.
Cisco Browser and IP Phone Agent (BIPPA) Service
The service that enables CAD-BE and IP phone agents to log in and out of
Unified ICM, change agent states, and enter wrap-up data and reason codes
without having the Agent Desktop software. This service works in conjunction with
the Services feature of Unified CM and Cisco IP phones.
Cisco Chat Service
A service that acts as a message broker between the Chat clients and Supervisor
Desktop. It is in constant communication with all agents and supervisor desktops.
Cisco Enterprise Service
A server program that tracks calls in the system. It is used to attach IVR-collected
data to a call in order to make real-time call activity data available at the agent
desktop.
Cisco LDAP Monitor Service
The service that starts Directory Services and then monitors it to ensure that it
keeps running.
Cisco Licensing and Resource Manager Service
The service that distributes licenses to clients and oversees the health of the CAD
services. In the event of a service failure, it initiates the failover process.
Cisco Recording & Playback Service
The service that extends the capabilities of the Cisco VoIP Monitor Service by
allowing supervisors and agents to record and play back calls.
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Cisco Recording and Statistics Service
A service that maintains a 7-day history of agent and team statistics. It also
manages call recording.
Cisco Sync Service
The service that connects to the Unified ICM logger SQL database via and ODBC
connection and retrieves agent, supervisor, team, and skill information. It then
compares the information with the information in Directory Services and adds,
updates, or deletes entries as needed to stay consistent with the Unified ICM
configuration.
Cisco Unified Mobile Agent
Cisco Unified Mobile Agent provides the capability to use remote agents when
staffing contact centers. It provides an encrypted, secure, IT-managed connection
over broadband to the home. The agents have complete access to all the contact
center applications.
Cisco VoIP Monitor Service
A service that enables supervisors to silently monitor agents. The service
accomplishes this by “sniffing” network traffic for voice packets.
Computer telephony integration (CTI)
The connection of a computer with a telephone switch that allows the computer to
issue commands and receive event information for calls and agents.
configuration file
The computer file that stores the settings for an application.
contact center
An expansion of a call center, so that it can make and receive not only phone
calls, but email, faxes, web chat messages, and so on.
CORBA
Common Object Request Broker Architecture. An architecture and specification
for creating, distributing, and managing distributed program objects in a network.
It allows programs at different locations and developed by different vendors to
communicate in a network through an interface broker.
country code
The 1–3 digit code that, in the world numbering plan, identifies each country or
integrated numbering plan in the world.
CTI
See computer telephony integration.
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D
data field
A piece of information about a phone call that is available for display in the Agent
Desktop interface.
data field condition
A logical statement about call data that evaluates as either true or false.
data router
In networks, a device that connects any number of IP local area networks (LANs).
data switch
In networks, a device that filters and forwards packets between LAN segments.
database
A collection of data structured and organized in a disciplined fashion so that
information of interest can be accessed quickly.
deflected call
A ringing call that is redirected to another extension without being answered first.
This typically happens when the call is answered by voice mail.
delimiter
A word or character that marks the beginning or end of a segment of data.
Desktop Administrator
The application used to administer Cisco Agent Desktop.
device
A unit (for example, a telephone) connected to the telephone system.
Dial Pad
The soft phone screen that enables an agent to dial a number.
dial plan
A description of the dialing arrangements for customer use on a telephone
network. For example, the local access code, local area code, etc.
dialed number information service (DNIS)
A telephony network feature that provides the number the caller dialed.
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Directory Services
Also known as LDAP. The service that all other CAD services register with at
startup. Clients use this service to request information about other CAD
components.
DNIS
See dialed number information service.
drop
To hang up or disconnect a phone call.
Dropped event
An event which indicates a call is disconnected.
DTMF
See Dual Tone Multi-Frequency.
dual tone multi-frequency (DTMF)
The term for touch tone dialing. In DTMF, when you touch a button on a push
button pad, it makes a tone which is actually a combination of two tones, one high
frequency and one low frequency. These are the beeps you hear when you dial a
phone number.
duplex environment
An operating environment that contains a primary and secondary service. If the
primary service fails, the secondary service takes over.

E
ECC variable
See expanded call context variable.
enterprise data
A piece of data available to CAD via the Cisco Enterprise Service.
Enterprise Service
See Cisco Enterprise Service.
Ethernet
A local area network standard. Like other LAN technologies, Ethernet is used to
connect computers, printers, workstations, terminals, servers, and other devices
within the same building or campus.
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event
An occurrence at the agent desktop. Events include: startup, shutdown, ringing,
answered, and dropped.
expanded call context variable
A Unified ICM term for a piece of information about a phone call. It must be
defined within Unified ICM.
extension
The internal telephone number at the agent desktop.
external application
A software application not belonging to CAD.

H
host
A server connected to a network.

I
ICM
See Unified Intelligent Contact Management.
Install Manager
The program that helps you install CAD on your system.
interactive voice response (IVR)
The use of a computer to interact verbally via a telephone with a caller. The
computer plays announcements and questions to the caller, and the caller replies
by entering information via touch tones, a rotary dial, or by speaking. “IVR” and
“VRU” are often used interchangeably. See voice response unit (VRU).
intercept
An intercept occurs when a supervisor uses the Intercept button to force a
transfer from an agent to the supervisor.
Internet protocol (IP)
This protocol specifies the format of packets, also called datagrams, and the
addressing scheme. Most networks combine IP with a higher-level protocol called
transport control protocol (TCP), which establishes a virtual connection between a
destination and a source.
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IP by itself is something like the postal system. It allows you to address a package
and drop it in the system, but there’s no direct link between you and the recipient.
TCP/IP, on the other hand, establishes a connection between two hosts so that
they can send messages back and forth for a period of time.
IP
See Internet protocol.
IP address
The Internet protocol address of a device.
IP Contact Center (IPCC)
Now known as Cisco Unified Contact Center (CC). A Cisco solution for an IP
contact center. Its components include IP IVR, Unified CM, and Unified ICM.
IP IVR
Cisco IP IVR is an IP-powered interactive voice response application that provides
an open and extensible foundation for the creation and delivery of IVR solutions
via Internet technology. It automates the handling of calls by autonomously
interacting with users.
IP phone
A phone that enables you to move multimedia traffic over any network that uses
Internet protocol (IP).
IP port
In TCP/IP and UDP networks, an endpoint to a logical connection.
IPCC
See IP Contact Center.
IVR
See interactive voice response.

L
LAN
See local area network.
Launch External Application action
An action that starts an external application from within Agent Desktop.
LCC
See logical contact center.
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LDAP
See lightweight directory access protocol.
LDAP Monitor Service
See Cisco LDAP Monitor Service.
LDAP Service
The service that all other CAD services register with at startup. Clients use this
service to request information about other CAD components.
License Administration
The application used to update the number of seats purchased in your CAD
system.
Licensing and Resource Manager Service
See Cisco Licensing and Resource Manager Service.
lightweight directory access protocol (LDAP)
Also known as Directory Services. LDAP defines a standard manner of organizing
directory hierarchies and a standard interface for clients to access directory
servers.
local area network (LAN)
Two or more computers, and other devices, connected by cable, generally within
the same building or campus.
local extension
See extension.
logical contact center (LCC)
The root of the LDAP tree where CAD applications query for information. It is used
to segregate logically separate call centers within the LDAP server.

M
macro
A series of prerecorded commands that accomplish a task.
macro hot key
In Desktop Administrator, the key used to pause the recording of a macro and to
display the macro recording menu.
macro recorder
The feature in Desktop Administrator used to record a macro.
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N
Normal mode
A display mode in which the interface appears when calls are present and
minimizes when idle.

P
pane
Section of an application window.
password
A series of alphanumeric characters required to log onto an application or server.
PBX
See private branch exchange.
peripheral ID
The number within the Unified ICM schema that identifies the peripheral device,
for example, the peripheral interface managers (PIMs) for VRU/IVR, ACD, or
Unified CM.
phone book
In Agent Desktop, any one of the stored phone directories. Agent Desktop
contains global phone books as well as an employee phone book.
plain old telephone service (POTS)
The basic service supplying standard telephones, telephone lines, and access to
the public switched network.
port
See IP port.
POTS
See plain old telephone service.
primary server
In a duplex environment, the main server used. If the primary server fails, the
secondary server takes over.
private branch exchange (PBX)
A private telephone network used within an enterprise. Users of the PBX share a
certain number of outside lines for making telephone calls external to the PBX.
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PSTN
See public switched telephone network.
public network
A network operated by common carriers or telecommunications administrations
for the provision of circuit switched, packet switched, and leased-line circuits to
the public.
public switched telephone network (PSTN)
Refers to the world’s collection of interconnected voice-oriented public telephone
networks, both commercial and government-owned.

R
real-time transport protocol (RTP)
An Internet protocol for transmitting real-time data such as audio and video.
recent call list
A list of an agent’s 100 most recently made phone calls, automatically kept in the
Dial Pad window.
Recording & Playback Service
See Cisco Recording & Playback Service.
Recording and Statistics Service
See Cisco Recording and Statistics Service.
Ringing event
The event that occurs when the phone rings. See Event.
RTP
See real-time transport protocol.
rule
A set of 1–3 data field conditions. If any or all the conditions that constitute the
rule are evaluated as true, then the rule is met. Rules that are met trigger events
and actions.
Run Macro action
An action that starts and runs a macro.
scalar variable
An extended call context (ECC) variable that stores a single piece of data.
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screen pop
The delivery of caller-specific information onto the agent’s computer screen
(“populating” the screen).

S
seat
An instance of Agent Desktop, Supervisor Desktop, or other CAD applications.
secondary server
In a duplex environment, the backup server. If the primary server fails, the
secondary server takes over.
shortcut key
A keyboard key or key combination (also known as a “hotkey” or “keyboard
accelerator key”) that invokes a particular command that is generally faster to use
than clicking the mouse through a menu.
Shutdown event
The event that occurs when Agent Desktop shuts down. See event.
skill
An ability (expertise in a particular type of software, fluency in a foreign language,
for example) of a contact center agent. Calls can be routed based on agent skills
(skill-based routing) for better customer service.
soft phone
A software phone, such as Agent Desktop’s dial pad.
Startup event
The event that occurs when Agent Desktop starts up. See event.
status bar
The area on the Agent Desktop or Supervisor Desktop interface that displays the
status of the agent and of the CAD system.
Stealth mode
A display mode in which an application appears as an icon in the system tray
unless maximized by the agent.
supervisor
The leader and/or manager of a team of agents.
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Supervisor Desktop
The application used by contact center supervisors to manage agent teams in real
time.
Sync Service
See Cisco Sync Service.

T
task button
One of a series of up to 10 buttons on the Agent Desktop interface to which
actions can be assigned.
team
A group of agents who report to the same supervisor.
Team Performance Message (TPM)
A message the supervisor can create to display in Agent Desktop for a set length
of time to communicate important information. The TPM can be scrolling or
non-scrolling, depending on how the supervisor configures it.
threshold
The acceptable amount of time a call can remain at a particular device or call
center. Caution or warning icons are displayed in the Enterprise Data window
when thresholds are met or exceeded for a call.
touch tones
See dual tone multi-frequency.
TPM
See Team Performance Message.
transfer
A phone switch feature that allows moving a call from one extension to another.
transfer, blind
A transfer in which the active call is transferred to the third party without ensuring
that the transfer is successful (picked up at the other end).
transfer, supervised
A transfer in which you speak to the third party to whom the call is being
transferred before connecting the active call, in order to confirm that the transfer
can be made successfully.
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user ID
An identifier that designates a particular user and that is required to log into an
application or server.

U
Unified Intelligent Contact Management (Unified ICM)
A Cisco computer telephony integration application that collects data and profiles
customers from the network to the agent’s desktop, and coordinates the delivery
of voice and data to a targeted answering resource across the enterprise. Using
network-provided data, caller-entered digits, and information obtained from a
customer profile database, Unified ICM determines who is calling and why, and
routes the call to the appropriate area in the contact center.
user interface
An application’s look and feel to the user.

V
virtual private network (VPN)
A network created by renting or acquiring some part of someone else’s network (a
phone company, an Internet provider) and used to communicate between a
company’s offices.
voice gateway router
A combination of hardware and software that links a POTS telephone network to
an IP data network.
voice monitoring
The ability of a supervisor to monitor an agent’s phone conversations without
being heard and without letting the agent knowing it is happening.
voice over IP (VoIP)
A category of hardware and software that enables people to use Internet protocol
as the transmission medium for telephone calls.
voice packet
A digitized sample of a voice conversation sent over a network.
voice response unit (VRU)
The computer used to interact verbally via a telephone with a caller. The computer
plays announcements and questions to the caller, and the caller replies by
entering information via touch tones, a rotary dial, or by speaking. “VRU” and
“IVR” are often used interchangeably. See interactive voice response (IVR).
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VoIP Monitor Service
See Cisco VoIP Monitor Service.
VoIP
See Cisco VoIP Monitor Service.
VPN
See virtual private network.
VRU
See voice response unit.

W
wild card
Special characters used to represent one or more characters in a string. An
asterisk (*) represents several characters and a question mark (?) represents a
single character.
work flow
A sequence of actions that takes place when specific event/rule criteria are met.
work flow group
A group that shares a common set of work flows.
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adding a new action 97
availability 96
deleting 98
editing 98
importing and exporting 98
types
agent notification 102
agent state 103
call control 105
HTTP 106
IPC 113
launch external application 115
outbound dialer 132
run macro 116
set enterprise data 125
timer 127
utility 128
Agent management work flows
general procedure 91
overview 91
setting up CAD activity and agent state work
flows 93
setting up time of day work flows 93
Agents
changing work flow group assignment 166
configuring 166
Assigning phones to a VoIP monitor service 156
Automated updates 17
Automatic state changes 54
enabling/disabling 54

home page 73
setup 71
work sites 74

C
Call activity 61
setting up thresholds 61
Cisco Desktop Administrator
display pane 19
feature levels 12
interface 18
menu bars 18
navigation tree pane 19
passwords 21
starting 15
toolbars 18
user privileges 20
Cisco Desktop Monitoring Console 197
how to use 198
Cisco Unified Outbound Dialer 131
actions 132
and voice contact work flows 88
dialing modes 131
enterprise data 134
toolbar 133
Contact lists
adding SMEs 181
configuring 177
creating 178
deleting 179
editing 180
finding 179
finding SMEs 182

B
D
Browser 72
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renaming 69
Database synchronization 24
Desktop Administrator
accessing the web application 138
forcibly unlocking 160
introduction 11
logging in 138
what’s new 12
Desktop and Server Monitoring and Recording 153
enabling 154
Desktop monitoring
enabling 154
Dial strings 27
North American format 27
variable length format 35
Display pane 19

E
Enterprise Data
configuring 142
Enterprise Data window 60
Call Activity 61
Data 60
External contacts
adding 186
configuring 186
deleting 189
editing 189
finding 188

F
Feature levels 12
Fields 143
creating custom field 143
deleting 146
editing 145

H
High priority chat messages 129

I
Integrated browser. See Browser
Interface 18
Introduction 171
IPC receive events 74
IPC Agent Notification action 79
IPC Blind Conference action 77
IPC Blind Transfer action 76
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IPC High Priority Chat action 79
IPC Make Call action 76
IPC Record action 79
IPC Set Variable action 80
IPC Supervised Conference action 78
IPC Supervised Transfer action 77

L
Layouts 147
copying 151
creating a custom layout 147
deleting 152
editing 152
Login credentials
Agent Desktop 22
Cisco Desktop Administrator 21
Cisco Supervisor Desktop 22

M
Macro actions 116
allowed keystrokes 119
inserting data fields 121, 122
recording a macro 120
recording tips 117
Menu bar 18
Monitor service
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configuring default 155
removing 156
Monitoring console 197
how to use 198

N
North American dial string format 27
advanced external dialing 32
advanced internal dialing 30
miscellaneous 34
outgoing calls 29
telephone number display 28

O
Outbound Dialer. See Cisco Unified Outbound Dialer

P
Passwords
Agent Desktop 22
Cisco Desktop Administrator 21
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Personnel Configuration node 165
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Remote access 74
Removing VoIP Monitor/Recording & Playback services 156
Reserved reason codes 47

S
Searching Desktop Administrator 139
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Thresholds 61
Toolbar 64
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Desktop Administrator 18
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Variable length dial string format 35
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Voice contact work flows 81
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overview 82
setting up a new work flow 84
voice contact classification 83
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W
Wild card searches 87
Work Flow Configuration node 25
Work flow groups 57, 191
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automatic state changes 54
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U
Unified Presence
configuring server 172
Unlocking Desktop Administrator 160
User Interface window 64
Browser setup 71
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Remote Access tab 74
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